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WARNING

To ensure the equipment described by this User Manual, as well as the equipment connected to
and used with it, operates satisfactorily and safely, all applicable local and national codes that
apply to installing and operating the equipment must be followed. This includes the National
Electric Code in the USA and other applicable legislation, regulations, and codes in practice
elsewhere. Since codes can vary geographically and can change with time, it is the user’'s
responsibility to determine which standards and codes apply, and to comply with them.

FAILURE TO COMPLY WITH APPLICABLE CODES AND STANDARDS CAN RESULT IN
DAMAGE TO EQUIPMENT AND/OR SERIOUS INJURY TO PERSONNEL.

Persons supervising and performing installation or maintenance must be suitably qualified and
competent in these duties, and should carefully study this User Manual and any other manuals
referred to by it prior to installation and/or operation of the equipment.

The contents of the User Manual are believed to be correct at the time of printing; however, no
responsibility is assumed for inaccuracies. In the interests of a commitment to a policy of
continuous development and improvement, the manufacturer reserves the right to change the
specification of the product or it's performance or the contents of the User Manual without notice.
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SECTION 1
GENERAL DESCRIPTION

1.1 FEATURES

Performs high speed control functions of Rutherford Decorator/Basecoater to speeds in excess of
2000 CPM. This includes speed compensated print carriage and varnish unit trip, which eliminates
inside deco and varnish problems, and three can pin chain (bad can) blow-off which reduces scrap.

High speed front-end upgrade package which interfaces with existing control system.

Performs the following control functions:

1) Detection of miss-loaded cans.

2) Damaged can blow-off.

3) Speed compensated print carriage trip control.

4) Speed compensated varnish unit trip control.

5) Three can (bad can) pin chain blow-off.

6) Single select-a-can QC pin chain blow-off.

7) Can gate open/close control.

8) Alarm detection: infeed track jam, no can transfer (can on mandrel), and timing signal fail
detection.

9) DataAcquisition: Total number of good cans printed, total number of blow-offs, trips per
spindle, etc. (for both current shift and last shift)

10) Automatic Form Roll Throw-off at infeed track jam or can gate closed.

Built-in 2-Line X 40 character sealed display with 24 key membrane keypad allows local
viewing of collected data (can count, blow-off count, trips per spindle) by operator and set-up of
al user variables (key switch enabled) by authorized personnel.

Interfaces directly with machine mounted resolver, can/no can sensor and all trip and blow-off
solenoids.

Based on high performance M4500 PL C/PL S module which, allows easy trouble-shooting and
user customization using SY Sdev (DOS or Windows™ based) programming package.

Built-in PLS provides all machine timing, eliminating need for an additional PLS.

Can be used on all Rutherford Basecoaters, (both carriage trip models and two coater roll
models), aswell as all Rutherford Decorator models.
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SECTION 1
GENERAL DESCRIPTION

1.2 FUNCTIONAL DESCRIPTION

The HSL-CD4 Decorator/Basecoater high speed control package is an electronic upgrade package
for the Rutherford decorator/basecoater which detects miss-loaded cans, performs speed
compensated print trip, varnish trip, and three can (bad can) blow-off at speeds in excess of 2000
CPM.

In addition, the package provides:
1) Select-A-Can Pin Chain Blow-off for print quality verification.
2) Alarm Detection including:
Infeed Track Jam.
No Can Transfer (can on mandrel).
Timing Signal Failure.

3) Data Collection (both for the current shift and previous (last) shift) including:
Total Good Can Count.
Blow-off Counts
Trips per Spindle.

The package interfaces directly to the machine mounted resolver, can/no can sensor, trip and blow-
off solenoids as well as the host PLC viadiscrete DC 1/0.

The CD4 control system is not a dedicated "black box", but isinstead, implemented using the high
performance SY STEMS M4500 PLC/PLS module. This allows easy customization by either SEA or
the end user. The M4500 module is programmed using the SY Sdev programming package (DOS or
Windows™ based), which allows the module to be programmed in any combination of Ladder or
High-level (subset of "C"), as well as perform on-line monitoring and trouble-shooting. The M4500
module incorporates a built-in PLS which interfaces directly to the machine mounted resolver and
provides all machine timing, eliminating the need for an external PLS.,

1.3 SPEED COMPENSATED PRINT CARRIAGE TRIP AND VARNISH UNIT CONTROL

Speed compensated print carriage and varnish unit trip at speeds in excess of 2000 CPM is
incorporated to compensate for the response time of the carriage (or varnish unit). The print carriage
(or varnish unit) is always extended or retracted such that a miss-loaded mandrel is not printed (or
varnished) regardless of machine speed. The package achieves this by implementing a speed
compensation algorithm that "leads" the trip point by the response time of the carriage (or varnish
unit). The control is capable of "leading” the trip point by up to two stations (60msec at 2000 CPM).
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SECTION 1
GENERAL DESCRIPTION

Note: A single mandrel trip is possible at speeds up to 1200 CPM, atwo station trip is
recommended for speeds above 1200 CPM.

1.4 BAD CAN AND SELECT-A-CAN PIN CHAIN BLOW-OFF

Both the “Bad Can” pin chain blow-off and “ Select-A-Can” pin chain blow-off incorporate speed
compensation to compensate for the response time of the blow-off solenoids regardless of machine
speed. This allows accurate rejection of a single can from the pin chain at speeds in excess of 2000
CPM. The bad can blow-off is activated automatically to reject miss-loaded cans from the pin chain.

The “ Select-A-Can” feature allows the user to dial in a mandrel number, either at aremote PB
station or from the Keypad/Display and blow-off one can printed on that mandrel. Mandrels 1
through 24 can be individually blown-off this way to verify the print quality of each mandrel. Two
other select-a-can blow-off modes are also available (blanket and mandrel). The blanket mode
blows off consecutive cans printed on each blanket, starting with blanket 1. The mandrel blow-off
mode blows off 24 consecutive cans printed on all 24 mandrels, starting with mandrel 1.

The following variables can be set by the user for the bad can blow-off:
Number of pinsto the pin chain blow-off port (up to 999).
Number of cansto blow-off for each bad can (three is usually required when varnish is used),
Both the "ON" and "off" solenoid response time (used by the speed compensation algorithm).

The following variables can be set by the user for the select-a-can blow-off:
QC shift offset (1 to 24) which is used to match the actual mandrel number to the selected
mandrel number.
Number of blankets on blanket wheel.
Both the "ON" and "off" solenoid response times.

1.5 AUTOMATIC FORM ROLL THROW-OFF

Automatic form roll throw-off isincorporated to throw off the form rollsin the event of an infeed
track jam or when the can gate is closed. This prevents the blankets from over inking when no cans
are printed under these conditions, which in turn reduces the number of cans, which have to be
blown off once the jam is cleared or the infeed is opened. This can aso be incorporated into the
ductor rollsto prevent the transfer of ink into the station under these same conditions.
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SECTION 1
GENERAL DESCRIPTION

1.6 ALARM DETECTION
The package detects the following alarms:

INFEED TRACK JAM: Theinfeed track jam alarm occurs when 6 consecutive empty mandrels
are detected by the can/no can sensor after the can gate is opened.

NO CAN TRANSFER: The no can transfer alarm occurs when the no can transfer sensor detects a
can on amandrel after the disk transfer location.

TIMING SIGNAL FAIL: Thetiming signa fail occurs when any of the timing signals generated in
the PL S section fail to change state periodically while the machine is running.

The above darms are available to the host PL C via discrete outputs. These should be used to stop
the machine and indicate the problem when any one of the alarms occurs.

1.7 DATA COLLECTION
The following datais collected for both the current shift and the previous (last) shift:

1) Tota number of good cans printed

2) Tota number of cans blown-off

3) Tota number of miss-loaded cans (bad cans)
4) Tota number of restart blow-offs

5) Tota number of manual blow-offs

6) Total number of select-a-can QC blow-offs
7) Total trips per spindle (for each spindle)

This data can be viewed locally on the display sent to the host PLC via RS-232 communications
(MODBUS or Allen-Bradley DF1 protocols) using the optional $4516 serial communications board.
Thisinformation is updated ("current” shift transferred to "Last" shift) based on the change of state
of adiscrete input. Thisinput can be activated on an 8 or 12 hour shift basis or alternatively could
be activated manually on alabel run basis depending on the user's preference.

In addition to the shift data collection, a separate buffer is available to collect trips per spindle
counts as a diagnostics aid to the operator for trouble-shooting aloading problem on a specific
mandrel. Unlike the shift data, these counts can be reset manually by the operator at will. This
allows the operator to note an abnormally high count on a specific mandrel, attempt to correct the
problem, reset the counts and then check the counts at a latter time to determine if the problem is
corrected. This data can be viewed on the Keypad/Display.
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SECTION 2
INSTALLATION

The standard HSL-CD4 package is provided for back-panel mounting inside the existing user's
control cabinet. In addition, the HSL-CD4 can be purchased in a self contained NEMA 12 enclosure
for mounting adjacent to the existing control cabinet by specifying part number HSL-CD4-ENCL.

2.1 WHAT'S INCLUDED

Depending on which package is purchased, verify that the following items are included when
unpacking the HSL-CDA4:

2.1.1 HSL-CD4 (for back-panel mounting)

lea. HSL-CD4 back-panel for mounting in the existing user's control cabinet including the

following:
lea. M4500 PLC/PLS module
lea. P4500 Power Supply
lea. D4591 Display with ribbon cable for mounting in the existing control cabinet door
lea. HSL-CD4 User's Manual
lea. M4500 User's Manual
lea. HSL-CD4 Program Disk

2.1.2 HSL-CD4-ENCL (with NEMA 12 ENCLOSURE)

lea. HSL-CD4 NEMA 12 enclosure including the following:
lea. M4500 PLC/PLS module
lea. P4500 Power Supply
lea. D4591 Display/Keypad
lea. HSL-CD4 User's Manual
lea. M4500 User's Manual
lea. HSL-CD4 Program Disk
HSL-CD4 User’'s Manual SYSTEMS Electronics Group



SECTION 2
INSTALLATION

2.1.3 HSL-CD4 OPTIONS (PURCHASED SEPARATELY)

The following items can be purchased separately as required or desired. All items are compatible
with both the back-panel mountable package or the NEMA 12 enclosed package:

lea. $4516 Data Communications Board (MODBUS and DF1 protocols)
lea. HSL-QCSTA Remote Select-A-Can PB station

lea. HSL-DSP Remote RPM/Position Display

lea. RSV34-MSI Resolver

lea. RSV-RSCBLE-XX Resolver Cable

2.2 POWER REQUIRED

The HSL-CD4 is powered from 115VAC/230VAC 50/60HZ and +24VDC. The 115VAC/230VAC
is used to power the M4500 module while the +24VDC is used to power the +24VDC |/O (sensors,
trip and blow-off solenoids).

Note: +24VDC solenoids must be used for al trip and blow-off solenoids. These provide a much
more consistent and repeatabl e response time than 115V A C solenoids.

Assuming +24V DC solenoids were used in the existing system, the +24VDC current required by the
HSL-CD4 is no more than the existing systems +24VDC current requirement, therefore the existing
+24V DC power supply should be adequate.
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SECTION 2
INSTALLATION

2.3 MOUNTING AND WIRING THE HSL-CD4

If installing the HSL-CD4 package mounted in the NEMA 12 enclosure, mount the HSL-CD4
NEMA 12 enclosure in proximity to the existing control cabinet. If installing the HSL-CD4-BP
package, mount the back-panel in the existing control cabinet.

Referring to the figure below create a cut-out in the existing control cabinet door and mount the
D4591 display.
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D4591 Recommended Panel Door Cut-out

Note: The D4591 must be located within 6 feet of the M4500 module to avoid EMI pick-up on the
Display ribbon cable. Connect the ribbon cable from the M4500 module to the D4591 module.
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Referring to the electrical control schematic at the back of this manual, wire the HSL-CD4 to the
existing control system as follows:

Note: Keepal +24VDC wiring, resolver cable, and sensor cable wiring away from high voltage
wiring. Wire the machine mounted resolver directly to the 8-pin resolver input connector on the
M4500.

1) Incoming Power: 115VAC-230VAC to FU1, neutral to 900 and ground to GND. +24VDC to
501 and common to 500.

2) Interlocks from existing control system to HSL-CD4 (terminals 110 through 119).
3) Interlocksto existing control system from HSL-CD4 (terminals O22 through O25).

4) Carriage Trip, Varnish Unit Trip, Damaged Can Blow-off, Pin Chain Blow-off and Can Feed
solenoids (terminals O10 through O21).

5) Can/No Can Sensor, Spindle No.1 1.D. Sensor and No Transfer Sensor (terminals 108, 109, 121)
using three conductor shielded cables. The shields of the sensor cables should betied to earth
ground at aterminal inside the existing control cabinet and |eft floating at the sensors.

6) Set-Up Enable key switch (if desired) to allow entry to set-up variables through Keypad/Display.

7) Resolver cable from resolver (or existing PLS) to 8-pin resolver input connector on the M4500
using athree pair, two conductor shielded cable. The shield of the resolver cable should be tied
to the "SHLD" terminal of the M4500 resolver input connector. Make sure the resolver cable
shield isleft floating at the resolver.

2.4 MOUNTING THE HSL-QCSTA

The HSL-QCSTA is used to blow-off a can from a selected spindle (or blanket) from the pin chain
for quality verification. If the optional HSL-QCSTA remote select-a-can PB station was purchased,
mount it in the vicinity of the pin chain QC blow-off port in a convenient location for the operator.
Wire the HSL-QCSTA to the HSL-CD4 panel referring to the electrical control schematic at the
back of this manual.
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2.5 MOUNTING THE HSL-DSP REMOTE DISPLAY

The HSL-DSPisaremote 4 digit BCD display which displays either the current CPM or resolver
position as selected by the operator. If the optional HSL-DSP remote RPM/Position display was
purchased, make a cut-out in the operator's control console for the display where desired. Prior to
mounting, remove the back cover of the display and set the dip switches as outlined on the electrical
control schematic at the back of this manual. Mount the display and wire per the schematic at the
back of this manual. A selector switch can also be mounted and wired as shown to select either
CPM or position.

2.6 MOUNTING THE RSV34-MS1 RESOLVER (IF REQUIRED)

The HSL-CD4 is designed to interface to aresolver (not encoder) for machine timing. If the
machine is not already equipped with aresolver, then the existing encoder will have to be removed
and an RSV 34-M S1 resolver will have to be mounted init's place. If thisisthe case, refer to the
RSV 34-MS1 data sheet for details on mounting the resolver.

Note: The resolver must make one revolution for each spindle (24 revolutions per spindle wheel
revolution). Use the RSV-RSCBLE cable to connect the resolver to the HSL-CD4. Route the
resolver cable in a separate conduit, away from all other high voltage and control wiring. Wire the
cable directly to the 8-pin resolver connector on the M4500 (see section 2.3— Mounting and Wiring
the HSL-CD4).

2.7 MOUNTING THE SPINDLE #1 |1.D. SENSOR (NOT PROVIDED)

If the machine is not already provided with a spindle #1 1.D. sensor, then one will have to be
mounted. This sensor is used to determine which spindle is the #1 spindle for both the QC select-a
can blow-off and the trips per spindle count. This must see atarget once every revolution of the
spindle wheel (once every 24 spindles). Any non-discriminating 10-30VDC proximity sensor can be
used and it can be mounted anywhere around the periphery of the spindle wheel. The target it looks
at should be either alarge steel bolt head or 1" by 1" square stedl target mounted on the spindle
wheel in the vicinity of spindle #1.
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SECTION 2
INSTALLATION

2.8 HSL-CD4 SOFTWARE INSTALLATION

Follow the steps below to install either the Windows or DOS based setup programs and PLC
application program on a PC used to support the HSL-CD4 control system.

2.8.1 WINDOWS™ BASED SETUP PROGRAM INSTALLATION

The RTFCD7 setup program is compatible with Windows 95/98/M E/2000/X P operating systems
and is used to:

1)
2)
3)
4)
5)

Setup (tune) the user adjustable variables.

Adjust the timing channel set-points.

Download the application program to the M4500 module.

Download (restore) or upload (save) the user setup variables from the M4500.
View “Shift” and “Trips per Spindle” data.

To install the set-up software, perform the following steps:

1)
2)
3)

4)

5)

Insert the HSL-CD4 CD into the drive
From the Windows desktop, “Click” Start and then select run.
From the “Run” dialog box, “Click” the Browse button.

Select the drive with HSL-CD4 CD. Select the “ setup.exe” file and “ Click” Open and then
Ok.

Thiswill initiate the installation process. Follow the instructions that appear on the screen to
complete the installation process. The RTFCD7 setup program can be executed from the
“Systems” folder located in Programs.

HSL.-CD4 User’s Manual SYSTEMS Electronics Group
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INSTALLATION

2.8.2 DOS BASED SETUP PROGRAM INSTALLATION

The HSLCD4 set-up software is used to:

1) Setup (tune) the user adjustable variables.

2) Adjust the timing channel set-points.

3) Download the application program to the M4500 module.

4) Download (restore) or upload (save) the user setup variables from the M4500 to disk.
5) View “Shift” and “ Trips per Spindle’ data.

To install the DOS based set-up software perform the following steps:

1)

2)

3)

4)

Create adirectory off the root for each decorator. These will be used to store the
"HSLCD4.EXE" setup program and set-up data for each decorator.

Create these directories by typing the following at the DOS prompt:

MD \HSLDECI1<ENTER> (line 1 Decorator)

MD \HSLDEC2<ENTER> (line 2 Decorator)

MD \HSLDEC3<ENTER> (line 3 Decorator)
efc.

Install the "PROGRAMS" disk into the drive. For each "HSLDEC" directory you created, switch
to that directory and install the "HSLCD4" set-up programs by typing the following at the DOS
prompt (Line 1 decorator is shown):

CD \HSLDECI1<ENTER>
A:INSTALL<ENTER>

Add each decorator's set-up program to your computer's menu software by creating a selection
for each decorator called "SET-UP DECO LINEL" for the line #1 decorator, "SET-UP DECO
LINE2" for the line #2 decorator, etc.. The DOS commands executed for these selections should
be (Line 1 decorator is shown):

For the"SET-UP DECO LINE1" selection:
CD \HSLDEC1
HSLCD4 HSLCD4
CD \

To execute the respective decorator's set-up program, simply select the corresponding "SET-UP
DECO LINE" selection from the menu software's menu.

HSL-CD4 User’'s Manual SYSTEMS Electronics Group
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2.8.3 SYSdev PROGRAM DEVELOPMENT SOFTWARE INSTALLATION

The SY Sdev Program Devel opment software is used to perform on-line trouble-shooting and
program modifications to the HSL-CD4. If SY Sdev was purchased with the HSL-CD4 package and
isnot already installed on the your computer, install SY Sdev onto the hard drive of your computer
following the stepsin outlined in the SY Sdev Program Devel opment manual .

2.8.4 APPLICATION PROGRAM INSTALLATION

The application program is a SY Sdev based program, loaded into the M4500 module and performs
the HSL-CD4 logic. The program iswritten in a combination of Ladder logic and High-level. If the
user desires to make program changes or perform on-line monitoring of the program execution the
files, which constitute the HSL CD4 program, will have to be loaded onto the hard drive of the PC
used to support the system. The SY Sdev Program Development Software will also have to be
loaded on the PC. To install this program perform the following:

1) Install the “PROGRAMS’ disk into the drive.

2) For each of the "HSLDEC" directories (created in section 2.8.2), copy all the files from the disk
to each of these subdirectories.

2.9 MODIFY EXISTING PLC PROGRAM

Modify the existing control system PLC program to interface with the HSL-CD4 by incorporating
the following into the existing PLC ladder logic:

1) The damaged can blow-off, print carriage trip, varnish unit trip, and pin chain blow-off will be
controlled by the HSL-CDA4. If the existing host PL.C was previously controlling these functions,
thislogic can optionally be removed from the existing host PLC. In most cases this logic can be
left in the program as connecting the respective solenoids to the HSL-CD4 will effectively
defeat the logic.

2) Addthe"Infeed Track Jam" and "Can On Mandrel” (no transfer) alarms as inputs to the host
PL C. These should stop the machine anytime either of these darmsare "on".

3) Addthe"Carriage Auto Mode" and "Carriage Manual In" outputs into the PLC logic. When
both are "off" the carriage will be retracted. When the "Manual In" is"on", the carriage will be
extended (print position). When the "Auto Mode" is"on", the carriage is controlled by the
can/no can sensor.

HSL.-CD4 User’s Manual SYSTEMS Electronics Group
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4)

5)

6)

7)

8)

9)

SECTION 2
INSTALLATION

Add the "Varnish Auto Mode" and "Vanish Manual In" outputs into the PLC logic. When both
are "off" the varnish unit will be retracted. When the "Manual In" is"on", the varnish will be
extended (varnish position). When the "Auto Mode" is"on", the varnish unit is controlled by the
can/no can sensor.

Add the "Damaged Can Auto Mode" and "Damaged Can Manual On" outputs into the PLC
logic. When both are "off" the damaged can blow-off is disabled. When the "Manual On" is
"on", the damaged can blow-off is"on". When the "Auto Mode" is"on", the damaged can blow-
off is controlled by the can/no can sensor and infeed open.

Add the "Pin Chain Manual Blow-off" output to the PLC logic. This can be used as a manua
blow-off. When "on", the bad can pin chain blow-off is"on". When "off", the pin chain blow-off
functions normally, blowing off detected bad cans, restart cans, etc.

Add the "Can Feed Open" output to the PLC logic. When turned "on" while running, the infeed
istimed "open" with the can feed timing signal. When turned "off" while running, the infeed is
timed "closed" with the can feed timing signal. When the machine is stopped, turning this input
"on" and "off" will respectively "open" and "close" the can stop.

Add the "Main Drive On" output to the PLC logic. This should be "on" when the driveis
enabled (running) and should be "off" when the drive is disabled (this includes auto stop
conditions). Thisistrue for jog modes as well.

Add the"Alarm Reset" output. This signal should be "on" as long as the system reset push-
button is depressed.
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2.10 TUNING THE HSL-CD4

The HSL-CD4 is shipped from the factory with the PLC application program loaded in the M4500
module (PLC section) and the PLS channel set-point file"CD4TMG" loaded in the PL S section.
These standard programs are used to implement the decorator or basecoater algorithms. In most
cases, the following user variables and timing signals may have to be altered to tune the HSL-CD4
to the actual decorator it is controlling.

Once the system isinstalled and powered back up, perform the following to set-up and tune the
HSL-CDA4. The set-up is performed using either the Keypad/Display or a PC running the set-up
program.

See the HSM-CD4/CD7 Keypad Quick Reference for key depress sequences for entering the
following parameters. See section 3 of this manual for a description of the Keypad commands and
menu displays of the Keypad/Display. See sections 4 and 5 for a description of menus and variables
and how to use the set-up programs.

2.10.1 DEFAULT SET-UP VARIABLES

As shipped, the user variables for the M4500 are set to the following defaults:

Print Carriage and Varnish Unit:

Print Carriage retract response time (msec) . 45
Print Carriage extend response time (msec) 45
Varnish Unit retract response time (msec) : 60
Varnish Unit extend response time (msec) : 60
Number of Shifts to Varnish Unit :5

Bad Can (pin chain) Blow-off:

# of cans to blow-off from infeed open 16
# of cans to blow-off from print at restart 14
# of cans to blow-off from varnish at restart 14
# of cans to blow-off for each misload 03
# of pins to pin chain blow-off port : 50
# of cans from infeed to can PRX : 6
Blow-off solenoid "on" response time (msec) 115
Blow-off solenoid "off" response time (msec) : 20
QC Can (select-a-can) Blow-off:
Blow-off solenoid "on" response time (msec) 115
Blow-off solenoid "off" response time (msec) : 20
QC can blow-off port shift offset 01
Blanket wheel segments : 8
Spindle Trip Offset :0
HSL.-CD4 User’s Manual SYSTEMS Electronics Group
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The"CD4TMG" timing channel file, as shipped, contains the following default timing set-points:

CHAN

CHOO:
CHOL1:
CHO2:
CHO3:
CHO4:
CHO5:
CHOG6:
CHO7:
CH10:
CH11:
CH12:
CH13:
CH14:
CH15:
CH16:
CH17:

ON

020
010
180
060
030
250
255
000
000

OFF

DESCRIPTION

060
050
000
250
200
290
295
140
180

Carriage trip timing
Varnish trip timing
Can/No Can clock

Damaged Can Blow-off (Low speed)
Damaged Can Blow-off (High speed)
Pin Chain Blow-off (bad can) timing
Select-A-Can (QC) Blow-off timing

Can Gate Timing
PLC Clock Timing

HSL-CD4 User’s Manual
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2.10.2 SET MACHINE ZERO

1) Position the machine at machine zero.

MANDREL CENTERED

IN NOTCH OR HOLE
I
|

— —_

BLANKET
WHEEL

Machine Zero Position

(as seen from back of machine)

2) Settheresolver offset. Using the Keypad/Display, perform the following:
a) Pressthe“Set-Up” key.
b) Pressthe#5 key —Zero Machine (set resolver offset).
c) Enter “0” to zero the resolver and set the offset. The timing channel set-up menu will be
displayed, showing the position, “POS.”, at zero.
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2.10.3 VERIFY LOCATION OF CAN/NO CAN SENSOR

Verify that the location of the can/no can sensor is at the 2nd spindle from 12 o'clock when the
machineis at zero.

| CAN/NO CAN SENSOR
|

CAN /
MANDREL

VARNISH
ROLLER

Location of Can/No Can Sensor

Verify the location of the Can/No Can sensor. Place a can on a spindle and slowly jog it past the
sensor. The sensor should first see the can at between 300 and O degrees. If it does, the location of
the sensor is correct.

Note: The Can/No Can sensor “ON” position can be viewed by selecting option #6 — View Critical
Input Positions, from the primary setup menu using the Keypad/Display.

If the sensor first sees the can between 0 and 30 degrees, the system will still function correctly but
the Damaged Can Blow-off (HI - CHO4) and (LOW - CHO3) timing signals may have to be
adjusted. If the Can/No Can sensor first sees the can outside the 300 to 30 degree range, the sensor
should be moved to within the 300 to O degree range.
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2.10.4 SET PIN CHAIN BLOW-OFF TIMING

1) Set the bad can (pin chain) blow-off timing (CHO5) such that the timing signal just turns “ON”
when the pin chain blow-off port is centered between Cans.

PREVIOUS (GOOD) CAN \

BLOW OFF PORT

BAD CAN
(TO BE BLOWN OFF)

Location of Blow-off Timing “ON” Position
(channel 05 or 06)

2) From the primary setup menu using the Keypad/Display, select option #3 — Set Machine Timing

(set-points, etc.) and perform the following;:

a) With the machine stopped, view the resolver position.

b) Select timing channel CHO5 — Pin Chain Blow-off.

c) Clear the channel (pressthe“CLEAR CHAN” key).

d) Enter anew set-point (pressthe“ENTER SET-POINT” key). The“ON” SETPOINT should
be the current position of the resolver (pressthe “ENTER” key). The“OFF’ SETPOINT
should be set 40 degrees after the “ON” set-point (pressthe “ENTER” key).

€) Search the channel to confirm only one set-point (one on setting and one off setting).
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2.10.5 SET # OF PINS TO PIN CHAIN BLOW-OFF PORT

Perform the following to set the "# of pinsto pin chain blow-off port":

Note: That the chain take-up must be after the bad can pin chain blow-off port for reliable pin
chain blow-off. If the take-up is before the port, the relative position of the port to the blow-off
timing will vary as the take-up moves, causing partial blow-offs to occur.

1)

2)

3)

4)

5)

6)

Count the number of pins from the spindle wheel to disc transfer location to the bad can pin
chain blow-off port

From the primary setup menu using the Keypad/Display, select option #2 — Set Pin Chain/QC
Blow-off Parameters. Pressthe“NEXT” key until “# PINS TO PIN CHAIN BLOW-OFF
PORT:” isdisplayed.

The number entered is the number counted minus 2 (thisis still just an approximation).

Set the "# CANS TO BLOW-OFF FOR EACH MISLOAD" (pressthe “PREV” key) equal to
five.

Run the machine at low speed. Open the infeed and alow cansto load and be printed. After
cans have passed the pin chain blow-off port, close the infeed and observe the number of cans
blown off.

Note: Half prints or silver cans may get through the line until this variable is set-up properly.

Adjust the number of pinsto pin chain blow-off such that whenever the infeed is closed, one
(half printed) can is consistently blown off.

If no cans are blown off, the number of pinsto pin chain blow-off istoo high (blow-off comes
on too late). Reduce the number of pinsto pin chain blow-off and repeat this step again.

If more than one can is blown off, the number of pinsistoo low (blow-off comes on too early).
Increase the number of pinsto pin chain blow-off and repeat this step again.

Set the "# CANS TO BLOW-OFF FOR EACH MISLOAD" equal to 3.Run the machine at low
speed with cans and verify that for each miss-loaded can, three bad cans are blown off (miss-
loaded silver can blown off at damaged can blow-off port, half print cans ahead and behind
miss-loaded can blown off at pin chain port). If not adjust "# of pinsto pin chain blow-off port"
accordingly until they are.
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Note: Oncethisvariable is set, it may be desirable to set the "# of cansto blow-off for each
misload" equal to 4 or 5 until the print carriage and varnish unit response times are set in steps 5 and
6. Thisis done so that the cans following the miss-load can be verified for proper print. Once thisis
done, the "# of cans to blow-off for each misload" can be set back to 3.

2.10.6 SET # OF CANS TO BLOW-OFF AT RESTART

From the primary setup menu using the Keypad/Display, select option #2 — Set Pin Chain/QC Blow-
off Parameters. Set the following infeed open/restart blow-off parameters (as desired):

a) "#of Cansto Blow-off at Infeed Open"
b) "# of Cansto Blow-off from Print at Restart"”
c) "# of Cansto Blow-off from Varnish at Restart”

2.10.7 SET # OF CANS FROM INFEED TO CAN PRX

This parameter is used to adjust the number of stations from the can gate solenoid to can/no can
sensor. Default valueis set to 6 stations. Some Rutherford decorators utilize an infeed star wheel,
adding an additional 6 (total 12) stations from infeed to can PRX.

Perform the following to set the "# of Cans from Infeed to Can PRX":

1) From the primary setup menu using the Keypad/Display, select option #2 — Set Pin Chain/QC
Blow-off Parameters. Pressthe “NEXT” key until “# OF CANS FROM INFEED TO CAN
PRX:" is displayed.

2) Initialy set thisvalueto 6. If aninfeed star wheel is used, set thisvalueto 12.

3) Run the machine at low speed. Open the infeed and allow cansto load and be printed. From the
default display of the Keypad/Display, observe the “BLOWOFFS’ field. At “Infeed Open” this
number should increment up by the number of cansto blow-off at infeed open. Observe that
this same number of cans are blown off at the bad can pin chain blow-off port.

4) If the number of cans blown off was less than the number counted, increase the number of cans
from infeed to can PRX by the difference.

5) If the number of cans blown off was more than the number counted, decrease the number of
cans from infeed to can PRX by the difference.
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6) Continue to adjust this parameter until the actual number of cans blown off at infeed openis
egual to the desired.

2.10.8 SET PRINT CARRIAGE AND VARNISH UNIT "RETRACT"/"EXTEND"
RESPONSE TIMES

The retract and extend response times is the amount of time the control system will lead the trip
point (CHQOO for the print carriage, CHO1 for the varnish unit) to compensate for the mechanical
response time of the machine. To verify the print carriage and varnish unit trip control, run the
machine at high speed, induce miss-loads and observe the cans blown off at the pin chain blow-off.

Note: Pressingthe “Blank Key” on the Keypad/Display while the default display is shown will
electronically induce a misload into the system.

The miss-loaded can should be completely silver. The can ahead of the miss-load (can the carriage
retracted on) should be blown off at the pin chain blow off port and should be 1/4 to 1/2 printed.
The can behind the miss-load (the can the carriage extended on) should be blown off at the pin chain
blow off port and should be 1/2 to 3/4 printed. Any additional cans blown off following the half
print behind the miss-load should be fully printed and of good quality print.

From the primary setup menu using the Keypad/Display, select option #1 — Set Carriage/Varnish
Response Times.

If the can ahead of the miss-load (carriage retracted on) isfully printed or more than half printed, the
"Print Carriage retract (out) response time" istoo short and the carriage is not retracting soon
enough. Increase the "Print Carriage retract (out) response time" by 5 milliseconds and try again.
Continue increasing this time until this can is 1/4 to 1/2 printed. If this can isless than 1/4 printed or
silver, the "Print Carriage retract (out) response time" istoo long and the carriage is retracting too
soon. Decrease the "Print Carriage retract (out) response time" by 5 milliseconds and try again.
Continue decreasing this time until this can is 1/4 to 1/2 printed (press the “NEXT” key).

If the can behind the miss-load (carriage extended on) is less than 1/2 printed or silver, the "Print
Carriage extend (in) response time" is too short and the carriage is not extending soon enough.
Increase the "Print Carriage extend (in) response time" by 5 milliseconds and try again. Continue
increasing thistime until thiscan is 1/2 to 3/4 printed. If this can is more than 3/4 printed or fully
printed, the "Print Carriage extend (in) response time" is too long and the carriage is extending too
soon. Decrease the "Print Carriage extend (in) response time" by 5 milliseconds and try again.
Continue decreasing this time until this canis 1/2 to 3/4 printed.

Note: The"extend (in)" timeisafunction of the "retract (out)" time. Therefore the "retract (out)"
time should always be set as desired first, before setting the "extend (in)" time.
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Prior to setting the varnish unit retract/extend response times, set the number of shifts to the varnish
unit. For older generation Rutherford Decorators, thisis set to "5". For newer decorators, thisis set
to "4". In generd, thisis set such that the varnish unit retracts out on the can ahead of the misloaded
spindle.

Set the varnish extend and retract response times in the same fashion as was done for the carriage. In
general, the miss-loaded can should have no varnish on it, the can ahead and behind should be
approximately 2/3 varnished.

2.10.9 SET QC BLOW-OFF SHIFT OFFSET
If the QC Can (select-a-can) feature is used, set the "QC can blow-off port shift offset" as follows:

1) Dial in spindle #1 on the Select-A-Can thumbwheel switch. This function can also be
performed from the Keypad/Display utilizing the “*QC BLOW-OFF” key and entering “1”.

2) With the machine running slowly, mark cans printed on spindle #1 so they can be identified
while on the pin chain.

3) Pressthe Select-A-Can pushbutton and compare the can that was actually blown off with the
location of acan marked on spindle #1.

4) From the primary setup menu using the Keypad/Display, select option #2 — Set Pin Chain/QC
Blow-off Parameters. Pressthe“NEXT” key until “# QC BLOW-OFF SHIFT OFFSET (1-24).”
isdisplayed. Add the difference between the can actually blown off and the marked can on
spindle #1 to the QC blow-off shift offset and enter this as the new offset number.

5) Continue to adjust the offset number until a can marked on spindle #1 is blown off.

Note: Thisvariable must be a number between 1 and 24 asthere is aways a can printed on spindle
#1 every 24 cans.
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2.10.10 SET BLANKET WHEEL SEGMENTS

The blanket wheel segmentsis the value used to blow-off a consecutive number of cans (starting
with blanket #1) whenever a*“Blanket” QC Blow-off isinitiated (QC blow-off code #25).

Set the number of “Blanket Wheel Segments’ as follows:

1) From the primary setup menu using the Keypad/Display, select option #2 — Set Pin Chain/QC
Blow-off Parameters. Pressthe“NEXT” key until “BLANKET WHEEL SEGMENTS (4-12):”
isdisplayed (last setup parameter in this menu).

2) Enter the number of segments on the blanket wheel.

2.10.11 SET SPINDLE TRIP SHIFT OFFSET
Set the " Spindle Trip Shift Offset" asfollows:

1) From the primary setup menu using the Keypad/Display, select option #2 — Set Pin Chain/QC
Blow-off Parameters. Pressthe“NEXT” key until “SPINDLE TRIP SHIFT OFFSET (0-23):” is
displayed (last setup parameter in this menu).

2) Initially set the "Spindle Trip Offset" to zero.

3) Wrap apiece of tape around spindle #1 such that cans will not load on this spindle. With the
machine running slowly open the can gate and verify that cans do not load on spindle #1 and that
the print carriage is tripped for that spindle.

4) Observethe“Trips per Spindle” data and determine which spindle number is being incremented.
The spindle number that should be incrementing is spindle #1. If it is not, subtract 1 from the
spindle number that is being incremented and enter this value as the “ Spindle Trip Shift Offset”.

5) Verify that the spindle #1 count is incremented every time the carriage trips for spindle #1. If it
still increments another spindle number, continue adjusting the " Spindle Trip Shift Offset” until
it does. Stop the machine and remove the tape from spindle #1. The machine is now set-up and
ready to run.
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2.11 M4500/P4500/D4591 INSTALLATION

Thefollowing is provided only as areference. These steps are performed by the factory prior to
shipping the HSL-CD4. These steps need only be performed in the event either the M4500 module,
PA4500 power supply, or D4591 display need to be replaced. Refer to the M4500 User's Manual for
genera details on installing the M4500, P4500, and D4591.

2.11.1 M4500 MODULE INSTALLATION

To install the M4500 module, perform the following:

1)

2)

3)

4)

Remove the cover from the M4500 chassis (retained with three captive screws on the lower
front of the cover and two captive screws on each side of the M4500 chassis).

Install $4563 (SLOTO0-0): Set the slot address dip switches (SW1) on the S4563 to the following
positions (slot0):

$4563: SW1 switchl = "OFF"
SW1 switch2 = "OFF"

Install the S4563 in Slot0-0 (furthest left slot) of the M4500 chassis.

Install $4568 (SLOTO-1): Set the slot address dip switches (SW1) on the S4568 to the following
positions (slotl):

S4568: SW1 switchl = "ON"
SW1 switch2 = "OFF"

Install the S4568 in Slot0-1 (slot next to $4563) of the M4500 chassis.

Install $4573 (SLOTO0-2): Set the slot address dip switches (SW1) on the S4573 to the following
positions (slot2):

HA573: SW1 switchl = "OFF"
SW1 switch2 = "ON"

Install the S4573 in Slot0-2 (slot next to $4568) of the M4500 chassis.
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5) Install $4516 (SLOTO0-3) (OPTIONAL): Set the ot address dip switches (SW2) on the 4516
to the following positions (slot3):

A516: SW2 switchl = "ON"
SW2 switch2 = "ON"

Set the RS-232/RS-422 select dip switches (SW1) on the $4516 to the following positions (RS-
232 selected):

$A516: SW1 switchl ="ON"
SW1 switch2 = "OFF"

Install the S4516 in Slot0-3 (slot next to $4573) of the M4500 chassis.

6) Install the cover back over the M4500, making sure all the board connectors protrude the dlotsin
the cover. Tighten the three captive screws on the lower front of the cover and the two captive
screws on each side of the M4500 chassis.

7) Connect the display ribbon cable to the connector on the back of the M4500 (the connector on
the cable is polarized and should mate with the connector on the M4500 only one way).

8) Mount the M4500 chassis to the HSL-CD4 back panel using four 8-32 screws.

9) With power to the P4500 "off", install the P4500 power supply cable to the +5/C/+12/C/-12
connector on the M4500 (the connector on the cable is polarized and should mate with the
connector on the M4500 only one way).

10) Install the respective field wiring arms on all the I/O boards of the M4500 (1/0 slots0 thru 2,
serial communications connector on USER PORT, resolver connector, and INO/IN1 connector).
Make sure all field wiring connectors are fully mated in the M4500.

2.11.2 P4500 POWER SUPPLY INSTALLATION
To install the P4500, perform the following steps:

1) Mount the P4500 to the HSL-CD4 in the mounting holes next to the M4500 (left side) using two
8-32 screws.

2) With power to the P4500 "off", install the P4500 power supply cable to the +5/C/+12/C/-12
connector on the M4500 (the connector on the cable is polarized and should mate with the
connector on the M4500 only one way).
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2.11.3 D4591 KEYPAD/DISPLAY INSTALLATION
To install the D4591, perform the following steps:

1) With the gasket installed on the mounting studs of the D4591, install the D4591 in the cut-out
either in the HSL-CD4 enclosure or the cut-out in the user's existing control cabinet. Secure the
display to the enclosure using 7ea. 8-32 nuts and external lock washers.

2) Connect the display ribbon cable to the connector on the lower back of the display (the
connector on the cable is polarized and should mate with connector on the M4500 only one

way).

2.11.4 DOWNLOAD HSLCD4 PROGRAM AND SET-UP DATA TO M4500

Once the M4500/P4500/D4591 are installed, perform the following to download the HSLCD4
application program to the M4500 as well as download the previously saved set-up data and timing
channel set-points:

1) Power up the M4500 and the IBM PC or compatible used to interface with the HSL-CDA4.

2) Connect an RS-232 cable from the computer COM port to the "PROG" port on the M4500.

3) Initiate the respective setup program (RTFCD7 for Windows systems, HSLCD4.exe for DOS
systems).

4) Download the HSL CD4 application program to the M4500. See section 4.2.3 for Windows
based systems, see section 5.7 for DOS.

5) Download the PLS timing set-points to the M4500. See section 4.2.4 for Windows based
systems, section 5.3 for DOS.

6) Download the previously saved set-up data to the M4500. See section 4.2.4 for Windows based
systems, section 5.8 for DOS.

7) The M4500 is now ready to run, loaded with HSLCD4 application program, timing set-points,
and set-up data.

Note: Double check the machine zero position and re-zero the resolver if necessary, prior to
running the machine.
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The keypad/display of the HSL-CD4 contains 24 keys consisting of 12 function keys, and a numeric
keypad and a 2 line by 40 character back-lit LCD display. The keypad/display can be used to view
data or activate the select-a-can QC blow-off to adjust the timing and all set-up parameters.

Ve

— — SYSTEMS
— % — ZFLECTRONICS
— GROUP, INC. N
MACHINE SPEED CPM:0000
GOOD CANS:0 BLOW—OFFS:0
TRIPS SET ENTE_R CLEAR
SPFI,I\ESLE up PONT || CHAN 2 3 ENTER
Qc
OS] pron- PR‘EV SEHa 51| 6 || es
NEXT
Sl ¥ || 8191 0
o J
J

The keypad/display allows the following to be viewed or adjusted:

1)
2)
3)
4)
5)
6)
7)
8)
9)

10) Test Print Carriage and Varnish Unit Trip Control.

Set Carriage/V arnish Response Times
Set Pin Chain/QC Blow-off Parameters

Set Machine Timing

Set Number of Shiftsto Varnish Unit

Set Machine Zero

View Can/No Can ON Position
View the Number of Trips per Spindle

View the Shift Data

Activate the select-a-can QC blow-off

The definitions of the keypad commands and menus are described in the following sections.

Note: For virtualy al the menus, the "NEXT" and "PREV" keys can be used to advance to the next
item of the menu or return to the previous item on the menu.
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3.1 DEFAULT SCREEN
The default screen (displayed when no other commands are active) contains the following data:

MACHINE SPEED (CPM):xxxx
GOOD CANS:XXXXXXX BLOW-OFFS:xXxXxxxx

Where the "Machine Speed" is the current speed of the decorator, the "Good Cans' field is the total
number of good cans printed so far into the current shift, and the "Blow-offs" field is the total
number of cans blown-off the machine (scrap) so far into the current shift. This display effectively
replaces a speed meter, and two can counters. This screen is always returned to when no commands
are active.

3.2"TRIPS PER SPINDLE" KEY

The Number of trips per spindle menu is provided to aid in the trouble-shooting of aloading
problem with a spindle or spindles. The total number of trips for each spindle since the last reset or
end of shift is displayed. The operator can reset these counts at any time to aid in the trouble-
shooting process. The data can be viewed simply be pressing this key. The display shows a series of
screens each with four spindles from 1 through 24 as shown below:

-- TRIPS (MIS-LOADS) PER SPINDLE --
1:XxXxXX 2 XXXX 3IXXXX 4:XXXX

Where the numbers 1 through 4 are the first 4 spindles and the "xxxx" would be the actual counts
for the respective spindles. Screens for spindles 5 thru 8, 9 thru 12, etc. are shown in thisfashion
each for atime delay of 10 seconds. In addition, the user can advance to the next screen or retard to
the previous screen by pressing the "NEXT" or "PREV" key respectively.

Thefina screen of this menu, prompts the user to reset the counts by pressing "0" or not to by
pressing "ESC". This provides the operator with the opportunity to reset the counts if desired for
trouble-shooting. If the counts are to be reset, pressthe "0" key, if not, pressthe "ESC" key. The
default screen will now be displayed again.

The"ESC" key can also be used at any time to abort the trips per spindle data display and return to
the default screen.
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3.3 "CURRENT SHIFT" KEY

The Current shift data menu displays the following information:
- Mis-loads:
Restart Blow-offs:
Manual Blow-offs:
QC Blow-offs:
Trips (Mis-loads) per Spindle (1-24):

Note: The Current shift "Good Cans" and "Blow-offs" are displayed as part of the default screen

This dataisthe totals so far into the current shift. This datais transferred to the "Last shift" data
when the end of shift input transfersfrom a"0" toa"1". This can be at the end of either an 8 or 12
hour shift or alternatively could be done at label changes such the data collected would be for label
runs rather than complete shifts. This data cannot be reset by the operator, only at the end of shift
input transition.

Good Cans: Thisisthetotal number of good cans printed so far into the shift. Thisis essentially a
can counte.

Blow-offs: Thisisthe total number of cans blown-off the machine. Thisincludes all types of blow-
offs: the three cans blown-off for every miss-loaded can, infeed open blow-offs, restart blow-offs,
manual blow-offs, sdect-a-can QC blow-offs, etc.

Mis-loads: Thisisthetotal number of miss-loaded cans (trips). These would be the actual number
of damaged cans that did not load properly on the machine. This gives an indication of
conveying/can handling problems.

Restart Blow-offs: Thisisthe total number of cans blown off when the infeed opened and from
the print station and varnish station at machine restart.

Manual Blow-offs: Thisisthe total number of cans blown-off by the operator using the Manual
Blow-off PB or selector switch.

QC Blow-offs: Thisisthe total number of cans blown-off by the operator with the Select-A-Can
QC station or QC Blow-off key on the HSL-CD4 keypad for quality verification.

Trips (Mis-loads) per Spindle (1-24): Thisisthetotal trips (mis-loads) for each spindle. A
disproportionately high count for a particular spindle indicates aloading problem for that spindle.
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3.4 "LAST SHIFT" KEY

The"Last Shift" dataisidentical to the current shift data except it isfor the previous 8 or 12 hour
shift or previous label run, how ever the shift collection is set-up. This allows data collection and
diagnostics to take place automatically over atwo shift period. Refer to section 3.3 —* Current Shift”
Key, for definitions of the datafieldsin the "Last Shift" data menu.

3.5"SET-UP" KEY

This selection is used to invoke the primary set-up menu. This consists of the following four
selections:

SET CARRIAGE/VARNISH RESPONSE TIMES
SET PIN CHAIN/QC BLOW-OFF PARAMETERS
SET MACHINE TIMING (SET-POINTS, ETC.)
SET NUMBER OF SHIFTSTO VARNISH UNIT
ZERO MACHINE (SET RESOLVER OFFSET)
VIEW CRITICAL INPUT POSITIONS

The set-up menu can be key switch protected such that only authorized personnel (those with the
key) can activate the selection. The "Set-up Enable" input must be "ON" to invoke the set-up menu.
When selected, each of the above selections will bring up a sub-menu with the corresponding set-up
parameters. The following sections describe these sub-menus and the definitions of the
corresponding variables. To select the respective set-up sub-menu, simply press the corresponding
numeric key (1 thru 6).
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3.5.1 SET CARRIAGE/VARNISH RESPONSE TIMES

This menu is activated when the "1" key (SET CARRIAGE / VARNISH RESPONSE TIMES) is
pressed while the primary set-up menu is active. See section 2.10.8 for a complete description of
how to adjust the print carriage and varnish unit response times.

The following four set-up parameters may then be adjusted or viewed:

PRINT CARRIAGE RETRACT (OUT) RESPONSE TIME (msec): Thisisthe time used to
lead the trip point to retract the print carriage (time from solenoid actuation to first break with
blanket) in milliseconds. The M4500 will activate the retract solenoid this amount of time ahead of
the print carriage unit trip timing (CHOO) (usually set at 40 to 50 milliseconds).

PRINT CARRIAGE EXTEND (IN) RESPONSE TIME (msec): Thisisthe time used to lead the
trip point to extend the carriage unit (time from solenoid actuation to first contact with blanket) in
milliseconds. The M4500 will activate the extend solenoid this amount of time ahead of the print
carriage unit trip timing (CHOO) (usually set at 40 to 50 milliseconds).

VARNISH UNIT RETRACT (OUT) RESPONSE TIME (msec): Thisisthe time used to lead
the trip point to retract the varnish unit (time from solenoid actuation to first break with varnish
wheel) in milliseconds. The M4500 will activate the extend solenoid this amount of time ahead of
the varnish unit trip timing (CHO1) (usually set at 60 milliseconds).

VARNISH UNIT EXTEND (IN) RESPONSE TIME (msec): Thisisthetimeto lead the trip
point to extend the varnish unit (time from solenoid actuation to first contact with varnish wheel) in
milliseconds. The M4500 will activate the extend solenoid this amount of time ahead of the varnish
unit trip timing (CHOL) (usually set at 60 milliseconds).

The"NEXT" and "PREV" keys can be used to advance to the next response time or the previous
time respectively. To change the currently displayed response time, simply enter the new value on
the numeric keypad and press <ENTER>. The value will be entered and the next response time
variable will automatically be displayed. When the last response time (Varnish extend time) is
entered, the primary set-up menu is again displayed. Pressing <ESC> at anytime will also exit you
back to the primary set-up menu.

Note: All response times entered must be in the range of 5 to 80 milliseconds.
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3.5.2 SET PIN CHAIN/QC BLOW-OFF PARAMETERS

This menu is activated when the "2" key (SET PIN CHAIN / QC BLOW-OFF PARAMETERYS) is
pressed while the primary set-up menu is active. The following blow-off set-up parameters may then
be adjusted or viewed:

# CANS TO BLOW-OFF AT INFEED OPEN: Thisisthe number of cans which will be blown
off when the infeed isfirst opened. Valid range: 0 to 99.

# TO BLOW-OFF FROM PRINT AT RESTART: Thisisthe number of cans which will be
blown off from the print station when the machine is restarted. Valid range: O to 99.

# CANS TO BLOW-OFF FROM VARNISH AT RESTART: Thisisthe number of canswhich
will be blown off from the varnish station when the machine is restarted. Valid range: O to 99.

# CANS TO BLOW-OFF FOR EACH MISLOAD: Thisisthe number of cans blown off at the
pin chain port when one miss-loaded can is detected (typically set at 3 cans).

# PINS TO PIN CHAIN BLOW-OFF PORT: Thisisthe number of pinsfrom the spindle wheel
to disk transfer location to the first can blown off at the Pin Chain blow-off port minus two. This
can be a number from 0 to 999.

# OF CANS FROM INFEED TO CAN PRX: This parameter is used to adjust the number of
stations from the can gate solenoid to can/no can sensor. Default valueis set to 6 stations. Some
Rutherford decorators utilize an infeed star wheel, adding an additional 6 (total 12) stations from
infeed to can PRX.

PIN CHAIN (BAD CAN) SOLENOID "ON" RESPONSE TIME (msec): Thisisthe time used
asthe"on" response time of the pin chain blow-off port (time from "on" solenoid actuation to first

air out port) in milliseconds. The M4500 will activate the solenoid this amount of time ahead of the
Pin Chain blow-off timing (CHO5) (usually set at 15 to 20 milliseconds). Valid range: 5 to 60 msec.

PIN CHAIN (BAD CAN) SOLENOID "OFF" RESPONSE TIME (msec): Thisisthetime used
asthe "off" response time of the pin chain blow-off port (time from "off" solenoid actuation to air
stopping at port) in milliseconds. The M4500 will activate the solenoid this amount of time ahead of
the Pin Chain blow-off timing (CHO5) (usually set at 15 to 20 milliseconds for double acting
solenoids and set at 25 to 30 milliseconds for single acting solenoids). Valid range: 5 to 60 msec.

QC BLOW-OFF SOLENOID "ON" RESPONSE TIME (msec): Thisisthetime used asthe
"on" response time of the QC blow-off port (time from "on" solenoid actuation to first air out port)
in milliseconds. The M4500 will activate the solenoid this amount of time ahead of the QC blow-off
timing (CHO6) (usually set at 15 to 20 milliseconds). Valid range: 5 to 60 msec.
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QC BLOW-OFF SOLENOID "OFF" RESPONSE TIME (msec): Thisisthe time used asthe
"off" response time of the QC blow-off port (time from "off" solenoid actuation to air stopping at
port) in milliseconds. The M4500 will activate the solenoid this amount of time ahead of the QC
blow-off timing (CHO6) (usually set at 15 to 20 milliseconds for double acting solenoids and set at
25 to 30 milliseconds for single acting solenoids). Valid range: 5 to 60 msec.

QC BLOW-OFF SHIFT OFFSET: Thisisthe number of spindles difference from detection of the
spindle #1 flag to the QC blow-off port. Thisis anumber between 1 and 24 and is empirically set by
selecting spindle #1 for blow-off and adjusting this value until the can from spindle #1 is the can
that is blown off.

BLANKET WHEEL SEGMENTS (4-12): The blanket wheel segmentsis the value used to blow-
off a consecutive number of cans (starting with blanket #1) whenever a“Blanket” QC Blow-off is
initiated (QC blow-off code #25).

SPINDLE TRIP SHIFT OFFSET: Thisisthe number of spindle difference from the detection of

the spindle #1 flag to the Can/No Can sensor. Thisis a number between 0 and 23 and is empirically
such that a miss-loaded can on spindle #1 increments the spindle #1 count in the "Trips per spindle”
menu (see section 2.10.11 — Set Spindle Trip Shift Offset).

The"NEXT" and "PREV" keys can be used to advance to the next parameter or the previous
parameter respectively. To change the currently displayed parameter, smply enter the new value on
the numeric keypad and press <ENTER>. The value will be entered and the next parameter will
automatically be displayed. When the last parameter (Spindle trip shift offset) is entered , the
primary set-up menu is again displayed. Pressing <ESC> at anytime will also exit you back to the
primary set-up menu.
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3.5.3 SET MACHINE TIMING (SET-POINTS, ETC.)
This selection brings up the timing set-point menu which displays the following fields:

CHuu SETPOINT:xxx [] "channel name"
RPM:yyyy POS:zzz OFFSET:wwww SCALE:360

Each field is defined as follows:

Field Definition
Chuu Currently selected channel (CHOO thru CH17) where "uu" is the octal channel
number.

SETPOINT:xxx  Channel "on" or "off" set-point where "xxx" is the set-point position

[] State of channel set-point (blank = "off", solid block character = "on")

"channel name"  selected channel name: (CHO0) PRINT CARRIAGE TRIP, (CHO1) VARNISH
UNIT TRIP, etc.

RPM:yyyy Current machine speed where "yyyy" isin CPM.

POS:zzz Current resolver position where "zzz" isin degrees.

OFFSET:wwww  Resolver offset where "wwww" is the offset in degrees.
SCALE:360 Resolver SCALE FACTOR (360 degrees per revolution).

In addition to displaying the timing set-point menu, the following keys are al'so enabled: "ENTER
SET-POINT", "CLEAR CHANNEL", "SELECT CHANNEL", and "SEARCH CHANNEL".

The"ENTER SET-POINT" key is used to enter anew set-point (both "on" and "off" set-points) in
the selected channel. The "CLEAR CHANNEL" key is used to clear all set-points from the selected
channel. The"SELECT CHANNEL" key is used to select a new channel for programming. The
"SEARCH CHANNEL" is used to view both the "on" and "off" set-pointsin the selected channel.

Searching Channel: To view the set-points in a channel ssimply press the "SEARCH
CHANNEL" key. The next "off" to "on" or "on" to "off" position is shown in the "SETPOINT"
field. If the transition was "of f" to "on", the state character [] will be a solid block. If the transition
was "on" to "off", the state character [] will be blank.
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Entering or Adjusting Set-point: To set or adjust atiming channel, perform the following:

1)

2)

3)

4)

Select the channel to be adjusted by pressing the "SELECT CHANNEL" key, entering the
channel number (00 to 17) and pressing enter. In addition, the "NEXT" and "PREV" keys can be
used to advance to the next channel or retard to the previous channel.

Press"CLEAR CHANNEL" to clear the existing set-point out.

Note: Entering a new set-point does not automatically clear the old set-point out. If the two set-
points are not in the same place, the channel will simply have two set-pointsin it if the old one
isnot cleared out first. Therefore always clear the channel before entering a new set-point. A set-
point may, however, be "extended" by programming another set-point onto an existing set-point
using either the existing "on" or "off" set-point as the starting position for the new set-point.
Thiswill result in one larger set-point.

Press"ENTER SET-POINT" to enter the new set-point. The display will then prompt ""ON"
SETPOINT:". Enter the position (in degrees) where the set-point should go "on" and press
<ENTER>. The display will now prompt ""OFF" SETPOINT:". Enter the position (in degrees)
where the set-point should go "off" and press <ENTER>. The channel will now be programmed
with a set-point that goes "on" at the "on" position entered and "off" at the "off" position entered.

Exit back to the primary set-up menu by pressing <ESC>. Exit back to the default screen by
pressing <ESC> again.

3.5.4 SET NUMBER OF SHIFTS TO VARNISH UNIT

Thisisthe number of spindles from the Can Sensor to the varnish unit minus 2. In genera, thisis
set such that the varnish unit retracts out on the can ahead of the misloaded spindle. For older
generation Rutherford Decorators, thisis set to "5". For newer decorators, thisis set to "4".
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3.5.5 ZERO MACHINE (SET RESOLVER OFFSET)

This selection is used to auto zero the resolver. To set the machine zero (resolver offset) perform the
following:

1) Select"3: SET MACHINE TIMING" and observe the "POS:" field. Verify that as the machineis
rotated forward (either jogging or barred) that the position increases linearly from O through 359.
If not, swap the S1 and S3 leads of the resolver at the M4500 resolver connector. Then verify
that the position then indeed does increase with forward movement. Press "ESC" to exit back to
the primary set-up menu.

2) Position the machine at machine zero (spindle aligned with V notch at top backside of the
machine frame, see section 2.10.2 - Set Machine Zero).

3) Auto zero the resolver by selecting "4: ZERO MACHINE" from the primary set-up menu. Enter
"0" to zero the resolver. The timing set-up menu will be displayed, now showing the "POS:" at
zero.

4) The M4500 will calculate the actual offset value required to make this the 000 position and will
display this number in the offset field.

5) Exit back to the primary set-up menu by pressing <ESC>. Exit back to the default screen by
pressing <ESC> again.

3.5.6 VIEW CRITICAL INPUT POSITIONS

This selection is used to view the “On” position of the Can/No Can sensor. To view critical input
positions perform the following:

1) Select"6: VIEW CRITICAL INPUT POSITIONS' and observe the can/no can PRX "POS:"
field. Verify the location of the Can/No Can sensor. Place a can on a spindle and slowly jog it
past the sensor. The sensor should first see the can at between 300 and O degrees. If it does, the
location of the sensor is correct.

2) If the sensor first sees the can between 0 and 30 degrees, the system will still function correctly
but the Damaged Can Blow-off (HI - CH04) and (LOW - CHO3) timing signals may have to be
adjusted. If the Can/No Can sensor first sees the can outside the 300 to 30 degree range, the
sensor should be moved to within the 300 to O degree range. Press "ESC" to exit back to the
primary set-up menu.
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3.6 "QC BLOW-OFF" KEY

This key is used to blow-off a can from a selected spindle at the Pin Chain QC Blow-off port. To
blow-off acan, pressthe"QC BLOW-OFF" key. The display will then prompt "Enter Spindle to
Blow Can off:". Enter the desired spindle number (1-24) and press enter. One can from that spindle
will be blown off at the Pin Chain QC blow-off port.

Note: Enteringina25 or 26 will initiate a consecutive can blow-off. Code 25 will initiate a
“Blanket” blow-off (one can from each blanket, starting with blanket #1). Code 26 will initiate a
“Mandrel” blow-off (one can from each mandrel, starting with mandrel #1).
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RTFCD7 WINDOWS BASED
SETUP PROGRAM REFERENCE

The Windows based set-up program is menu driven, allowing the user to easily view data, alter set-
up variables or set machine timing (machine offset, timing signal locations, etc.), using a PC
running the Windows (95/98/M E/2000/XP/NT) operating system. The set-up variables are used to
configure and tune the M4500 to match the configuration and performance of the specific decorator
(see Tuning the HSL-CD4, section 2.10).

Note: The set-up program is an on-line communications program used to interface with the M4500
module. The data displayed and set in the windows is communicated directly to the module, while
inthe “Online” edit mode. Therefore, prior to going online with the processor, make sure an RS-232
cable is connected from the COM port on the computer to the "PROG" port on the M4500. The
variables displayed while in the “Online” edit mode are read directly from the processor. Datais
saved to a“ Set-up Data’ file (*.sdt) whenever changes are made to a parameter or if the datais
uploaded from the processor.

I ] |
Edit Wiew ‘window Help
- Meszages
- System Normal -
Set-up Proagrani iz Currently OMLINE
—Machine CPFM-——— [ Good Cans - -0Q.C. Blow-off
[__‘ I_"—‘-_ ~ Spindle Humber ——
0 400.148 s Blanket Blow-aff
1 -.—I
l JE |
- Blow-offs
e [ SingeBlowof | MandelBlowot |
~Bad Can Blow-off
Test Trip/Blowalf |
System Message: All Faults Normal CONLINE  [10/6/2003 | 238PM
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4.1 GENERAL DESCRIPTION

Title Bar: At thetop of thewindow isthe“Title Bar”. Thetitle bar is used to display the name of
the working “ Set-up Data” file, as well as, the name of the active “Window”. Thetitle bar isdark if
the window is active and grayed if another window is active. The color depends on the settings of
the Display Properties of the Control Panel.

Status Bar: At the bottom of the window isthe * Status Bar”. The status bar is used to display
system messages, online or offline mode, as well as, the current time and date as set by the operating
system. The system messages panel displays general information about operation of the system.
The Online/Offline mode panel displays the status of the current set-up program mode of operation.
The mode of operation can be changed by simply double clicking the online/offline mode panel.

Hot Keys: Hot keys are activated by holding down the “ALT” key and simultaneously pressing the
underlined letter of the desired function. Almost every function can be activated by either pressing
aseries of hot keys or using the“TAB” key to move between fields.

Online/Offline Modes: The set-up program allows the user to make changes while “Online” with
the processor. The “Offlineg’ mode is used to preset parameters prior to download. All functions
are available to the user while “Online”, however, specific “Online” functions are disabled in the
“Offling” edit mode.

Note: Offline changes can only be made by enabling “ Offline Editing”, accessed under the “Edit”
menu.

Getting Help: The entire contents of the user’s manual is contained within the help file. Pressing
Ctrl+H will display the help file window. Pressing the F1 key will display the contentsfile. Hot
gpots alow jumps to other topics to display additional information as desired. Selecting About
RTFCD7 from the Help menu will display adialog box listing information about the current
revision of the setup program and how to obtain technical support.
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4.2 THE FILE MENU
The “File” menu allows the user to perform the following functions:

Create a“New” set-up “DataFile’.

Open an existing “Data File".

Save any changes made to the current “Data File” to disk.

Upload (save) Data from the Processor.

Download a SY Sdev (.sdv) program to the processor

Download (restore) Data from the current set-up “Data File” to the processor
Print a Report of the current set-up parameters.

Exit the set-up program

LS. RTFCD?Y - [unnamed] - [Main Display]
File Edit Wiew ‘Window Help
Open... [g Chrl+0
e Chl+S - System Mormal -- =l
S e A Set-up Proagrani iz Currently OMLINE
Export Shift Data..  Chl+x -
Upload [zave] Data * Good Cans — Q.C. Blow-off
Dawsnload Program FTRED Spindle Number ——
Daownload Data 2 - ’7 |1_A ‘ Blanket Blow-off |
=i
Frint Report... Chrl+P low-offs
EHit 4)1 69 | , ............ S !ng|EB|DW.fo‘I Mandre| B|Dwoff |
T
—Bad Can Blow-off
Test Trip/Blowalf |
Systemn Mezzage: All Faults Maormal OWNLINE ~ 10/6/2003 | 243 PM 2
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4.2.1 THE SET-UP DATA FILE

The set-up “Data File” (.sdt) isabinary accessfile, designed for fast file I/O operation. When the
set-up program isfirst invoked, the default set-up parameters are loaded into memory. If changes
are made to any of the set-up parameters (either online or offline), as well as shift data, the user will
be flagged to “ Save Changes’ upon exit of the program.

Note: Any windows based “ Set-up” program can open a set-up “DataFile’, however, the data
tables will not be properly aligned. The user will be alerted to the problem if a set-up datafile has
been created by either a different set-up program or a different revision of the software.

The set-up “DataFile” issimilar to that of aword processing file. When the program first starts a
default file isloaded and the user is able to make any changes as desired. The set-up program is
unaware of the settings and parameters that exist within the M4500. Therefore, to normalize the
set-up program with the processor, the user should define or open an existing file, then upload “All”
variables from the processor. This allows the user to either create a backup of the data or maintain
an existing file. The user can even open adatafile for another decorator, save the file to a new
name, make the necessary changes and simply download the new parameters to another processor.

The following functions can be accessed any time, from any set-up or display windows.

New: To create a“New” datafile, select “New” from the “File” menu or press“Ctrl + N”. This
creates a completely new file, loaded with the default variables and the word “[unnamed]” is
displayed in thetitle bar. If any changes were made to the existing file, the user is prompted to save
changesto the existing file.

Open: To“Open” and existing datafile, select “Open” from the “File” menu or press“Ctrl + O”.
This displays adialog box allowing the user to select an existing data file to open. The name of the
filewill be displayed in thetitle bar. 1f any changes were made to the existing file, the user will be
prompted to save any changes before terminating the program.

Save: To“Save’ datafileto disk, select “ Save’ from the “File” menu or press“Ctrl + S’. This
displays adialog box allowing the user to select afolder and enter aname for the file. The user will
be notified if the file already exists and the extension “.sdt” will automatically be added to thefile
name. If thisisa“New” file, the user will be prompted to enter afile name.

Save As: To savethedatafileto anew name, select “Save As’ from the “File’ menu.. This
displays adialog box allowing the user to select afolder and enter in a new name for thefile. The
user will be notified if the file exists and the extension “.sdt” will automatically be added to thefile
name.

Export Shift Data...: Thisfunction allows the user to export the shift datato a“Tab Delimited”
text file. Thisallowsthe user to easily use the shift data to produce production reports.
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4.2.2 UPLOAD (SAVE) DATA

The “Set-up” program allows the user to upload blow-off parameters, timing channel set-points and
shift data from the M4500 into a set-up “Data File”. Thisfunction is accessed from the “File” menu
and the user is given the choice of the following options:

S =] 3

H RTFCD7? - [unnamed] - [Main Display]
|File Edit Wiew ‘Window Help

Mesw... Clrl+h
Open... Chrl+0 =
Save Chil+5 - System Normal -- =
S e A Set-up Proagrani iz Currently OMLINE
Export Shift Data..  Chl+x -
Upload (savel Data Set-up Parameters —0.C. Blow-off
Dawsnload Program Tirning Chatinels Spindle Number ——
Download Data P ShiftData ’7 T = ‘ Blanket Blov-off |
=l
Frint Report... Chrl+P
EHit | , ............ S !ng|EB|DW.fo‘I Mandre| Blowaff I
]
— Bad Can Blow-off
Test Trip/Blowalf |
| Spstem Message: All Faults Normal | ONUME  [10/6/2003 | 305PM

Set-up Parameters: Thisoption uploads the “ Set-up” data from the M4500. Thisincludesthe
print carriage and varnish unit response times, as well as, blow-off parameters.

Timing Channels: This option uploads the “Machine Timing” channel set-points, as well as, the
PL S configuration and scale factor.

Shift Data: This option uploads the “ Shift Data” from the M4500. Thisincludesthe “Trips per
Spindle”’ data, the “ Current Shift” and the “Last Shift” data.

All: This option allows the user to completely upload “ All” of the set-up parameters, timing
channel set-points and shift data from the M4500.
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4.2.3 DOWNLOAD PROGRAM

The “Set-up” program allows the user to “Download” any SY Sdev program file to the M4500.

S RTFCD? - [unnamed] - [Main Display] =10
[ Fie Edit View ‘Window Help
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Note: To“Download” a SY Sdev program to the processor, the program must be “Online’. If
“Online” mode cannot be achieved, program download will not be executed. If the programis
currently “Offline”, the user will be prompted to first go “Online”.

Once selected, and the set-up program “Onling” with the processor, a dialog box will be displayed,
allowing the user to select the SY Sdev file to download.

Note: Only thefileswith the “.sdv” file extension will be displayed. It isimportant to keep in
mind that only avalid M4500 PLC SY Sdev file can be downloaded through the set-up program.
Care should be taken when selecting a program to download.

Once selected, a message box is displayed informing the user of the current program, revision and
checksum of the program loaded in the processor, as well as, that of the selected program. The user
must confirm their selection by clicking the “Yes’ command button. After the user confirms their
choice, program download isinitiated and the current program download address is displayed.
When program download is complete, the user is prompted to acknowledge. Control is passed back
to the main program and the set-up program remainsin an “Online” edit mode.
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4.2.4 DOWNLOAD (RESTORE) DATA

The set-up program allows the user to download “Set-up” parameters, timing channel set-points
and shift data to the M4500 from the set-up “Data File’. Thisfunction is accessed from the “File”
menu and the user is given the choice of the following options:
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Set-up Parameters: Thisoption downloads the “ Set-up” datato the M4500. Thisincludes print
carriage and varnish unit response times and blow-off parameters.

Timing Channels: This option downloads the “Machine Timing” channel set-points, aswell as
the PL S configuration and scale factor to the M4500 PLS.

Shift Data: This option downloads the “ Shift Data” to the M4500. Thisincludesthe “Trips per
Spindle’ data, the “ Current Shift” and the “Last Shift” data.

All: This option allows the user to completely download “All” of the set-up parameters, timing
channel set-points and shift data to the M4500.

Note: Only the values contained within the current data file are used. If the validity of the current
datafile is questionable, review the datain an “Offline” mode prior to download.
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4.2.5 PRINT REPORT

The “Set-up” program allows the user to generate a“Report” printout of al the set-up parameters,

timing channel set-points and shift

data. Thisfunction is accessed from the “File’” menu.

At the top of each page, the report displays the name of the set-up file being printed. At the bottom
of each page is the date and time the document was printed, as well as, the page number.

To printout areport of the settings contained in the set-up “Data File”, perform the following:

1) From the “File” menu, select “Print Report” or press“Ctrl + P’. This displays the “Print Setup”
dialog box, allowing the user to select a printer, as well as, the paper size and orientation. Once
the user selects “OK”, the report is generated and sent to the specified printer device. This
function makes use of the windows print manager, which alows the user to continue with their
work while the document is being printed.

4.3 THE EDIT MENU

The “Edit” menu allows the user to perform the following functions:

Enable/Disable Offline Editing.

Set-up the Comm Port.

LS RTFCDY - [unnamed] - [Main Display]

File | Edit View ‘window Help
Enable Offine Editing F2

I Comm Part Clrl+hd ~ System Nomal - |

Set-up Proarani iz Currently OHLINE

— Machine CPFM——— [ Good Cans- — B.C. Blow-off
I— |— Spindle Humber ——
0 400.148 2 Blanket Blow-off
1 -J
I IE=]
— Blow-offs
e [ S Blowail | Mandiel Blowolt |

— Bad Can Blow-off

Tl apEamat |

| System Meszage: All Faults Mormal

| OMUME 0/8/2003 | 322PM
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4.3.1 ENABLE OFFLINE EDITING

This function alows the user to perform “ Offline” editing on the currently loaded set-up datafile.
This alows the user the ability to make any necessary changes to the set-up parameters while not
online with the processor.

If offline editing is not enabled, the user is only able to view the set-up parameters and shift data.
When the program is first invoked, the default setting is offline editing disabled. The user will need
to specifically select “ Enable Offline Editing” from the edit menu (or press function key F2) to
enable/disabl e this feature.

4.3.2 SETUP COMM PORT

This function allows the user to specify the serial communications port and rate to talk to the
M4500. The programming port of the M4500 is set to 9600 baud.

X
~ Comm Port — Port Speed y

* Com 1 {+ 9500

" Cam 2 19200

" Com 3

" Com 4
LCancel |

Once selected, adialog box requesting the user to select a“Comm Port” and “Baud Rate” will be
displayed. The default setting is COM1 at 9600 baud. The option to select the 19200 baud rateisto
allow the user to communicate with the processor viathe $4516 serial communications board.

In most cases the user will only need to specify the communications port and leave the baud rate at
9600. If communication problems occur, make sure there is a secure connection from the PC to the
PLC. Then check the Comm port. In most cases the user will only need to select a new Comm port.
If communication problems persist there may be another program causing a conflict with the port.
Check the port configuration from the “ Settings” folder.

HSL-CD4 User’'s Manual SYSTEMS Electronics Group

-47 -



SECTION 4
RTFCD7 WINDOWS BASED
SETUP PROGRAM REFERENCE

4.4 THE VIEW MENU
The“View” menu allows the user to perform the following functions:
View the “ Target Board Interface”

View “Online’ Data
View “Offline’ Data

L RTFCD? - [unnamed] - [Main Display]
File Edit | Yiew Window Help
M Target Board Interface
v Online Data F3 - System Normal - =]
Offline Data F4 p Program is Currently OMLINE
=l
—Machine CPM——— [ Good Cans —Q.C. Blow-off
I— I— Spindle Humber ——
0 400.148 s Blanket Blow-aff
‘I —I
I =i
- Blow-offs
e [ S Blowail | Mandiel Blowoit |
—Bad Can Blow-off
Test Trip/Blowalf |
Systemn Mezzage: All Faults Maormal OWNLINE ~ 10/6/2003 | 3:29PM 2
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4.4.1 TARGET BOARD INTERFACE

This function alows the user to view fault codes, S3000 network communication error codes and
review the current “ldent” and “Revision” of the application program. Thisis accessed by the
“View” menu, by selecting “ Target Board Interface”.

: Target Board Interface =i _%XI

| Program |dent/Rewvision l Set Metwork Address l Set Time & Date |

— Internal Fault Code:
Current Fault: Code = 00H

IND Intemal Fault has Ocuned.

Lazt Faulk Code = 00H

IND Internal Fault has Ocumed.

EesetEatlts |
Corrective Action:

Mohe |
I |

— Communications Hetwork Ermmor Codes:
Current Comm Error: Code = 00H
iNn Metwork Comm Error.

Lazt Camm Error: Code = O0H
iNn Metwork Comm Error.

Once invoked, the set-up program will prompt the user to select a program to compare with the one
existing in the processor. Whether a program is selected or the user cancels, the setup program will
attempt to communicate with the M4500. If unsuccessful awarning message will be displayed,
prompting the user to either “Retry” or “Cancel” the operation. If the operation is canceled and
communication with the processor cannot be established the system will be placed in an “ Offline”
mode, however the “ Target Board Interface” window will be displayed.
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4.4.2 VIEW ONLINE DATA

This function allows the user to place the set-up program in an “Online” mode with the processor.
Thisis accessed by the “View” menu, by selecting “Online Data’ or by simply pressing the “F3”
function key.

Note: The program can be toggled between “Offline” and “Online” by simply double clicking on
the “Online” or “Offline” panel displayed in the status bar at the bottom of the window.

Once invoked, the set-up program will attempt to open the Comm port and communicate with the
M4500. If the set-up program is unsuccessful, a warning message will be displayed prompting the
user to either “Retry” or “Cancel” the operation. If the operation is canceled and communication
with the processor cannot be established the system will be placed in an “ Offline” edit mode.

Note: Anytime while the set-up program is*“Online” with the processor and communication is
interrupted, a warning message will be displayed, prompting the user to either “Retry” or “ Cancel”
the operation.

4.4.3 VIEW OFFLINE DATA

This function allows the user to place the set-up program in an “ Offline” mode. Thisis accessed by
the “View” menu, by selecting “ Offline Data” or by ssmply pressing the “F4” function key. This
allows the user to perform “Offline” editing. All values displayed in “Offline” edit mode reflect the
actual values contained in the currently loaded set-up datafile.

Note: The program can be toggled between “Online” and “ Offline” by simply double clicking on
the “Online” or “Offline” panel displayed in the status bar at the bottom of the window.

Once invoked, the set-up program will close the Comm port and cease communication with the
M4500.
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4.5 THE WINDOW MENU

The “Window” menu alows the user to select one of six different Display/Set-up windows to
modify set-up parameters, view shift data or receive feedback about the current status of the control
system.

E RTFCD7? - [unnamed] - [Main Display]
Fie Edit View | Wwindow Help
Messages MM W
2 Set-up Parameters
3 Senial Commurications System Noimal -
A Hnching T ding ogra is Currently OMLINE
5 Shift Data
L BI/0 States
—Machine CPM — Good Cans —0.C. Blow-off
Spindle Number ——
[o IEITALE . Blanket Blow-aff
‘I ‘.J
I =l
~ Blow-offs
e [ Sigie Biowoi | Mandel Blowff |
—Bad Can Blow-off
Test Trip/Blowalf |
| Spstem Message: All Faults Normal | ONUME  [10/6/2003 | 349PM

Once awindow menu item is selected, a check mark is placed next to the selected item and the
selected window is displayed with the name changed in the title bar of the main window.

Note: “Read” only variables are displayed in blue with a gray background. Any variables that can
be altered by the user are displayed in black with a white background. In most cases, a parameter
that can be changed by the user will have associated with it increment and decrement controls. The
user can either click on the desired parameter to adjust and enter in anew value, or use the
increment or decrement controls to change the value by 1 unit.
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4.5.1 THE MAIN DISPLAY WINDOW

The “Main Display” window is used to display the general state of the control system. Thiswindow
is selected from the “Window”.

I ] |
- Meszages
- System Normal -
Set-up Proagrani iz Currently OMLINE
—Machine CPFM-——— [ Good Cans - -0Q.C. Blow-off
[__‘ I_'—‘-_ ~ Spindle Humber ——
0 400.148 s Blanket Blow-aff
1 -.—’
l JE |
- Blow-offs
e [ SingeBlowof | MandelBlowot |
~Bad Can Blow-off
Test Trip/Blowalf |
| System Message: Al Fauits Nomal | ONUME  [10/6/2003 | 238PM

Thefollowing isalist of the functions of the “Main Display” window.

Messages: The“Messages’ display is continuously updated. It displays alarm and status
messages specific to the M4500, as well as, the current “Online” or “ Offling” status of the set-up
program. By simply scrolling the display, the user is able to view al active alarm and status
messages. If no alarm or status messages are active, a default message is displayed.

Machine CPM: Thisdisplay isonly active while “Online” and displays the current speed of the
machinein “ Cans Per Minute’.

Good Cans: Thisdisplay isthe”Current Shift” good can count.

Blow-offs: Thisdisplay isthe “Current Shift” total blow-off count.
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Q.C. Blow-off: Thisdisplay isonly active while “Online” and it allows the operator to perform a
“ QC Select-A-Can” blow-off.
The operator can perform a“Single’ blow-off by entering in the desired spindle number and
clicking the “ Single Blow-off” command button.
The operator can perform a“Blanket” blow-off by clicking the “Blanket Blow-off” command
button. The blanket blow-off will initiate a blow-off sequence such that a can printed by each
blanket is blown off at the QC blow-off port, starting with a can printed by blanket #1.
The operator can perform a“Mandrel” Blow-off by clicking the “Mandrel Blow-off” command
button. The mandrel blow-off will initiate a blow-off sequence such that a can printed on each
mandrel will be consecutively blown off at the QC blow-off port, starting with mandrel #1.

Bad Can Blow-off: Thisdisplay isonly active while“Online” and it allows the operator to test
the action of the control system by electronically inducing a mis-loaded or “Bad Can” into the
system. By clicking on the Test Trip/Blow-off command button, a“Bad Can” will be electronically
induced into the system to test the response of the control system dueto a“Mis-Loaded” can.

4.5.2 THE SETUP PARAMETERS WINDOW

The “ Set-up Parameters’ window is used to view and adjust any of the set-up parameters. This
window is selected from the “Window” menu.

S RTFCD7? - [unnamed] - [Set-Up] "3 _ol x|

File Edit “iew ‘Window Help

Frint Carmiage v amizh Unit | Blow-off Parametersi B_Iow-u::ffSoIenoidsl

— Print Carriage

Eetract[Dut]HespnnseTime[msec];I 45 ﬁ
EHtend[in]HespnnseTime[msec];I 45 3‘1

—Warnizh Unit

Retract [out] Responge Time [mzec): I g0 ﬁ
Extend (in) Rezponze Time [meec); I g0 ﬁ
Humber of Shifts toWarnish Unit: I A 3‘1

- Test Blow-off -

Bad Can Blow-off

| System Message: Al Faults Normal | ONUNE  [10/B2003 | 358PM

Thiswindow utilizesa“TAB” control to divide the set-up parameters into three categories, similar
to that of the Keypad/Display.
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Print Carriage/Varnish Unit: Thissection isused to set the print carriage “ Retract/Extend”
response times and the varnish unit “Retract/Extend” response times in the M4500. This section
contains the following selections:

1)

2)

3)

4)

5)

Print Carriage Retract (out) Response Time (msec): Thisisthe time used as the retract
response time of the carriage unit (time from solenoid actuation to first break with blanket) in
milliseconds. Thiswill activate the retract solenoid this amount of time ahead of the Carriage
unit trip timing (CHOO) (usually set at 40 to 50 milliseconds).

Print Carriage Extend (in) Response Time (msec): Thisisthe time used as the extend
response time of the carriage unit (time from solenoid actuation to first contact with blanket) in
milliseconds. Thiswill activate the extend solenoid this amount of time ahead of the Carriage
unit trip timing (CHOO) (usually set at 40 to 50 milliseconds).

Varnish Unit Retract (out) Response Time (msec): Thisisthe time used as the retract
response time of the varnish unit (time from solenoid actuation to first break with varnish wheel)
in milliseconds. Thiswill activate the extend solenoid this amount of time ahead of the Varnish
unit trip timing (CHOL) (usually set at 60 milliseconds).

Varnish Unit Extend (in) Response Time (msec): Thisisthe time used as the extend
response time of the varnish unit (time from solenoid actuation to first contact with varnish
wheel) in milliseconds. Thiswill activate the extend solenoid this amount of time ahead of the
Varnish unit trip timing (CHO1) (usually set at 60 milliseconds).

Number of Shifts to Varnish Unit: Thisisthe number of spindlesfrom the Can Sensor to
the varnish unit minus 2. In general thisis set such that the varnish unit retracts out on the can
ahead of the misloaded spindle. For older generation Rutherford Decoratorsthisis set to "5". For
newer decorators, thisis set to "4".
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Blow-off Parameters: This section isused to set the “Pin Chain/QC Blow-off” parametersin the
M4500.

2 RTFCD7? - [unnamed] - [Set-Up] _ol x|

File Edit “iew ‘Window Help

| Blow-off Solenoids |

— Blow-off Set-up - Test Blow-off
Number of Ping to Pin Chain Blow-off Port; 32 ﬁ Bad Can Blow-off |
Murber of Cans fram Infeed to Can PRE: rg_ﬁ
Murmber of Can ta Blaw-aff for E ach Miz-load: I_Tﬁ
Murmber of Cans to Blow-off at Infeed Dpen: m_ﬁ
Murmber of Cans to Blow-off from Print at Bestart: l_d_ﬁ
Murnber of Canz to Blow-aff from Varmizh at Bestart: [_4_ﬁ
G.C. Can Blow-off Port Shift Offset: [ 1 =]
Mumber of Segments on Blanket Wheel: l_.g_ﬁ

[.C. Can Blow-off |

| System Message: Al Fauits Nomal | ONUME  [10/6/2003 | 401 PM

Note: The*Bad Can Blow-off” command button will electronically induce a mis-loaded can into
the system, aswell as, the “ Q.C. Can Blow-off” will blow-off a can printed on spindle #1 at the QC
blow-off port.

1)

2)

3)

4)

Number of Pins to Pin Chain Blow-off Port: Thisisthe number of pinsfrom the spindle
wheel to disk transfer location to the first can blown off at the Pin Chain blow-off port minus
two. This can be a number from O to 999.

Number of Cans from Infeed to Can PRX: This parameter is used to adjust the number of
stations from the can gate solenoid to can/no can sensor. Default valueis set to 6 stations.
Some Rutherford decorators utilize an infeed star wheel, adding an additional 6 (total 12)
stations from infeed to can PRX.

Number of Cans to Blow-off for Each Mis-load: Thisis the number of cans blown off at
the pin chain port when one mis-loaded can is detected (typically set at 1 can).

Number of Cans to Blow-off at Infeed Open: Thisisthe number of cans which will be
blown off when theinfeed isfirst opened. To blow off no cans at infeed open, set equal to O, to
blow off one can set equal to 1, etc.
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5) Number of Cans to Blow-off from Print at Restart: Thisisthe number of cans which
will be blown off from the print station when the machine isrestarted. To blow off no cans at
restart, set equal to O, to blow off one can set equal to 1, etc.

6) Number of Cans to Blow-off from Varnish at Restart: Thisisthe number of canswhich
will be blown off from the varnish station when the machineis restarted. To blow off no cans at
restart, set equal to O, to blow off one can set equal to 1, etc.

7) Q.C. Can Blow-off Port Shift Offset: Thisisthe number of spindles difference from
detection of the spindle #1 flag to the QC blow-off port. Thisisanumber between 1 and 24 and
isempirically set by selecting spindle #1 for blow-off and adjusting this value until the can from
spindle #1 is the can that is blown off.

8) Number of Segments on Blanket Wheel: The blanket wheel segmentsis the value used to
blow-off a consecutive number of cans (starting with blanket #1) whenever a*Blanket” QC
Blow-off isinitiated (QC blow-off code #25).
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Blow-off Solenoids: This section isused to adjust the response times of the “Bad Can” and
“QC” blow-off solenoid in the M4500.

1)

2)

3)

4)

2 RTFCD7? - [unnamed] - [Set-Up] 3 ol x|
File Edit “iew ‘Window Help

—Solenoid Hezponse Times

OM OFF
[mzec) [mzec)

Bad Can Blow-off Solenoid: [ 15 =] 20 =
0.C. Blowoff Sclenaid: [ 15 [ 20 &

Spstem Message: All Faults Normal CONLINE  [10/6/2003 | 412PM

Bad Can Blow-off Solenoid “ON” Response Time: Thisisthetime used as the "on"
response time of the pin chain blow-off port (time from "on" solenoid actuation to first air out
port) in milliseconds. The M4500 will activate the solenoid “ON” this amount of time ahead of
the Pin Chain blow-off “ON” position (usually set at 15 to 20 milliseconds).

Bad Can Blow-off Solenoid “Off” Response Time: Thisisthe time used as the "off"
response time of the pin chain blow-off port (time from "off" solenoid actuation to air stopping
at port) in milliseconds. The M4500 will activate the solenoid “OFF’ this amount of time ahead
of the Pin Chain blow-off “ON” position (usually set at 15 to 20 milliseconds for double acting
solenoids and set at 25 to 30 milliseconds for single acting solenoids).

Q.C Can Blow-off Solenoid “ON” Response Time: Thisisthe time used asthe "on"
response time of the QC blow-off port (time from "on" solenoid actuation to first air out port) in
milliseconds. The M4500 will activate the solenoid “ON” this amount of time ahead of the QC
blow-off timing “ON” position (usually set at 15 to 20 milliseconds).

Q.C. Can Blow-off Solenoid “Off” Response Time: Thisisthe time used as the "off"
response time of the QC blow-off port (time from "off" solenoid actuation to air stopping at
port) in milliseconds. The M4500 will activate the solenoid “OFF” this amount of time ahead of
the QC blow-off timing “ON” position (usually set at 15 to 20 milliseconds for double acting
solenoids and set at 25 to 30 milliseconds for single acting solenoids).
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4.5.3 THE SERIAL COMMUNICATIONS WINDOW

The Serial Communications window is used to view the configuration status of the S4516 serid
communications board (if installed), aswell as, view the status of the Allen-Bradley DF1
communication protocol and set-up the Allen-Bradley PLC communication parameters. From this
window the user can view or adjust the following parameters:

View the $4516 configuration status.

View the $4516-DF1 serial communication status.

View the Allen-Bradley Link Layer serial communication status.

Select the Allen-Bradley PLC type (PLC5 or SLC500) to communicate to.
View/Set the Allen-Bradley PLC destination node.

Select the starting Allen-Bradley PLC destination file number.

ol x|
- 54516-DF1 Communication Status — DF1 Communication Set-up
54515 Configuration Status: | [2] Success B __j
FLCH -
Transmit Data Status | (0] Unknoven Status
Destination Hade: i 1 j
Trarsmit Data Status (prev]: | [0] Unknown Status ST —
esination File Number: =
Current Tranzaction: l 1 | =
Active Command: | Read
Mumber of BYTES Received: l o
Received Command BIT Status l Command
-~ A/B Link Layer Status
Statusz:
| [00] Success - Mo Enar
Current Tranzaction Received: i 0
|System Message: All Faulks Mormal I_D_NLINE |1IJ_.I"E;2-DES i_:1-1_5_F'M 7

S4516 Configuration Status: Thisdisplaysthe current state of the configuration of the S4516
serial communications board. System function sfunc19(); ($4516 configuration) is used to set the
4516 configuration (network node address, network baud rate and USER port baud rate). This
must be executed prior to executing ether system functions 10, 11 or 13. System function 19 is
generally executed in the “Initialization” file of the user program.
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The following values are returned from a system function 19 call:
= Busy.
= Done (4516 Successfully configured).
= Invalid Parameter (either network node address, network baud rate or USER port baud
rateisinvalid).
4 = Timeout (no response form S4516)
32 = Hardware ACK error from $4516
34 = Invalid 4516 Slot Address (W8156 must be loaded with the slot address of the S4516,
prior to executing system function 19).

Transmit Data Status: Thisrepresents the state of the data packet transmission and will
typically display either “Busy” or “Done”. If there are problems delivering the message packet, the
response code, along with a description, will be displayed.

Note: The*Transmit Data Status (prev.)” is used to view the last or previous status.
Current Transaction: Thisisthe*Transaction” number delivered to the Allen-Bradley PLC.

Active Command: Thisdisplayseither “Read” or “Write”. Thisisused to view the command
type of the current transaction.

Number of BYTES Received: Thisdisplaysthe current number of bytes received from either a
“Command” or “Reply” message packet.

Received Command BIT Status: Thisdisplays the state of the command received. If this
displays a“Reply”, then the command was sent from the M4500. If this displays “Command”, then
acommand action was received by the M4500.

A/B Link Layer Status: Thisdisplays the status of the receipt of the message packet sent to the
Allen-Bradley PLC. If the delivery is not successful, an error code along with a description is
displayed. Refer theto the Allen-Bradley Communication Protocol and Command Set reference
manual for more information on “Link Layer” error codes.

A/B Link Layer — Current Transaction Received: Thisisthe “Transaction” number received
from the Allen-Bradley PLC.

PLC Type: Thisisused to specify the“Type” of PLC the M4500 will communicateto. The user
can choose from “PLC5” or “SLC500”".

Note: This parameter should be set prior to communicating with an A/B processor.

Destination Node: Thisisused to set the node number of the A/B PLC to send and receive data
from. Thisaso displays the node number of the A/B PLC that send a“ Command” message packet.
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Destination File Number: Thisisthe file number the M4500 will read and write data from. See
Appendix B for adescription of the data read from and written to an Allen-Bradley PLC.

4.5.4 THE MACHINE TIMING WINDOW

The Machine Timing window is used to invoke the PLS programming command menus. From this
window, the user can view or adjust the following parameters.

Adjust Timing Channel setpoints.

Set the Main Crank resolver offset.

Clear or Recall a PLS timing channel.

View the current PLS configuration

Reset the PL S configuration to default settings.

H RTFCD7? - [unnamed] - [Machine Timing]

File Edit “iew ‘Window Help

Timing Channels | FLS Cnnfiguratinnl

— Timing Channels — Hesolver Dffzet -
ON OFF o =
Carriage Trip Timing [CHOO): I P O
: G = | Tl Set Offzet |
Wamish Trip Timing [CHOT): | 10 =3 | 50 =
CandNo Can Clack Timing (CHOZK [ 180 = [ 0 = | pLs Channel
Damaged Can Blow-of - Low [CHO3E | 60 = [250 < [0

Damaged Can Blow-o - High (CHogp [ 30 = [200 <

Becall Channel LClear Channel
Bad Can Blow-off Timing (CHOS): | 250 = [ 230 = | |
0.C. Blow-off Timing (CHOB): | 255 =} [295 =] | - Test Blow-off
R [0 = =
Can Gate Timing Timing [CHO7): 0[S 140 5 Bad Can Blow-off |
PLC Clack Timing [CH10}: I ] j 1an ::,I
Can/No Can Sensor OW Position: | 0 ST |
RPh: O | Position: 85 | Offset 333 | Scale: 360
| Spstem Message: All Faults Normal | ONUME  [10/6/2003 | 436PM

In addition, the following parameters are displayed at the bottom of this window:
RPM: Thisisthe current speed in “Revolutions per Minute” of the main crank resolver.
Position: Thisisthe current “Position” in degrees of the main crank resolver.

Offset: Thisisthe current resolver offset (set in degrees).
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Scale: Thisisthe scale factor of the resolver or the number of divisionsin one revolution.

Note: The General Timing Signal Locations section provides a complete description of each
timing channel signal.

Zeroing the Machine (setting the resolver offset): To set machine zero, perform the
following:

1)

2)

3)

4)

5)

6)

7)

Connect an RS-232 SY Sdev cable from the COM port on the computer to the “PROG” port on
the M4500.

From the “Window” menu, select “Machine Timing”.

From the “View” menu, select “Online Data’. The set-up program will attempt to communicate
with the processor and place the system into an “Online” mode of operation.

Observe the “Position” field at the bottom of the window. Verify that asthe machineis rotated
forward, that the position increases linearly from 0 through 359 degrees. If not, swap the S1 and
S3 leads at the resolver connector on the M4500. Then, verify that the position does indeed
increase with forward movement.

Position the machine at machine zero (spindle aligned with V notch at top backside of machine
frame, see section 2.10.2 - Set Machine Zero).

Auto zero the resolver by entering “0” in the “Resolver Offset” field and clicking the “ Set
Offset” command button. A message box will appear, prompting the user to confirm their
choice. Select “Yes’ to set the resolver offset.

The M4500 will calculate the actual offset value required to make thisthe “0” position. The
new offset value will be displayed in the “Offset” field and the position will then read zero.
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Adjusting the Timing Channel Setpoints: To set any of the timing signal setpoints, perform
the following:

Note: Any changes made to the timing channel setpoints will be saved as part of the setup datafile.

1)

2)

3)

4)

5)

Connect an RS-232 SY Sdev cable from the COM port on the computer to the “PROG” port on
the M4510.

From the “Window” menu, select “Machine Timing”.

From the “View” menu, select “Online Data’. The set-up program will attempt to communicate
with the processor and place the system into an “ Online” mode of operation.

Set all channels per the section 6 — General Timing Signal Locations. Set-points for a particular
channel are either entered in the field or adjusted by using the increment/decrement controls.

Note: Only one set-point is used per channel.

If achannel needsto be “Recalled” or “Cleared”, enter the desired channel number into the
“PLS Channel” field. Click the“Recall Channel” command button to recall the setpoints. Click
the “Clear Channel” command button the completely clear all setpoints for the selected channel.

Note: If achannel has been cleared or the “On” and “ Off” setpoints have the same setting, the
set-point will be displayed as “*****”,
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Resetting the PLS Configuration: Asan aid to the user the current PLS configuration is
displayed in the “PLS Configuration” tab of thiswindow. The PLS configuration should only be
reset if anew module has been installed. To reset the PLS configuration, click the “Reset PLS
Config” command button. This function only resets the PLS configuration to the default settings.

LB RTFCD?Y - [unnamed] - [Machine Timing]

File Edit “iew ‘Window Help

Timing Channels | P

— Speed Compenszation PLS Configuration

CHOD [meec): I 0 Mumber of PLS Channels: I 16
CHO [meec): I 0 PLS Program: I 0

CHOZ(mseck [ O
CHO3fmsec) [ O
CHO4 fmsecy [ 0
CHOS fmsecy [ O
CHOS fmsecy [ 0
CHO7 fmsecy [ 0

Beset PLS Config |

RPM: 0 | Position; 85 Offeet. 333 | Seale: 360
System Message: All Faults Nomal | oNUME  10s8/2003 | 437PM
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4.5.5 THE SHIFT DATA WINDOW

The “ Shift Data” window is used to view the shift data collected by the M4500. Thiswindow is
selected from the “Window” menu.

2 RTFCD7? - [unnamed] - [Shift Data] _ol x|

File Edit “iew ‘Window Help

Trips Per Spindle | Curent Ghift | Last Shift ]

— Spindle Trip
# [ 3 ga [ 4
Spindle #1 Trip Qffset: [ 0 =
T w [ 23 #g [ 15
ripped Spindle:
#a [ 10 w5 [ 3

Tatal Trips: 237 e e ,_13 =
Reset Trips | #5 2 17 |_5.
1 wa[ 3
w [ 4 ma [ 4
1
2
1

w0 [ 2
w21 [ 16
w2z [ 23
w1 [ 14 sz 7
3 IREEE - T

| System Message: Al Fauits Nomal | ONUME  [10/6/2003 | 438PM

Thiswindow utilizesa“TAB” control to divide the set-up parameters into three categories, similar
to that of the Keypad/Display. These sections are as follows:

Trips per Spindle: The Number of trips per spindle display is provided to aid in the trouble-
shooting of aloading problem with a spindle or spindles. The total number of trips for each spindle
since the last reset or end of shift isdisplayed. The operator can reset these counts at anytime to aid
in the trouble-shooting process.

The following dataiis displayed in the "Trips per Spindle" section:

1) Spindle #1 Trip Offset: The"Spindle Trip Offset" can be entered from this section. Thisis
used to compensate for the location of the can/no can sensor and the spindle #1 1.D. sensor
location. Usethe” Tripped Spindle” display to adjust the offset value. Follow the procedure
outlined in section 2.10.11 — Set Spindle Trip Shift Off set.

2) Spindle #xx Trips: Thisisthe total number of trips for each spindle. This datais displayed
and updated continuously in the respective field for each spindle. A disproportionately high
count for a particular spindle indicates aloading problem for that spindle.
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Current Shift Data: Thissection isused to view the “Current Shift” data. This dataisthe totals
so far into the shift. Thisdataistransferred to the "Last shift" at the end of either an 8 or 12 hour
shift or alternatively could be done at l1abel changes such that the data collected would be for |abel
runs rather than complete shifts. This data can be reset by the user from this section.

S RTFCD?7 - [unnamed] - [Shift Data] o Zlolx]

File Edit “iew ‘Window Help

ILastshin |

— Current Shift

Total Good Cans: I 400,148
f#14 I 48

#1 30 #13 I 29

#2 63

#3 44 ﬂ'ISI 33
#4 43 ﬂ'lEl 48

Total Blow-offs: I 4,169
Bad Can Bloww-affs: I 2,795

b anwal Blove-offs: E40
#5 42 #17 I i

(.C. Blow-offs: 176
#B 29 #18 I 30

Fiestart Blow-affs: Laiat

#7 23 #19 I 47
#i 3 #20 I 32
#3 32 #21 I 58

Tatal Trips: | 1.078

paglahet wo[ 31 s &
Transfer Data I f11 I 47 #23 | 50

#12' 50 #24' 57

| System Message: Al Fauits Nomal ONLINE  [10/6/2003 | 439PM

Note: The*"Transfer Data’ command button is only active while “Online”.

1)

2)

3)

4)

5)

Total Good Cans: Thisisthe total number of good cans printed so far into the shift. Thisis
essentially a can counter.

Total Blow-offs: Thisisthetotal number of cans blown-off the machine. Thisincludes all
types of blow-offs: the can(s) blown-off for each mis-load, infeed open blow-offs, restart blow-
offs, manual blow-offs, select-a-can QC blow-offs, etc.

Total Bad Cans or Mis-loads: Thisisthetotal number of mis-loaded cans (trips). These
would be the actual number of damaged cans that did not load properly on the machine. This
gives an indication of conveying/can handling problems.

Manual Blow-offs: Thisisthetotal number of cans blown-off by the operator using the
Manual Blow-off PB or selector switch.

QC Blow-offs: Thisisthetotal number of cans blown-off by the operator with the Select-A-
Can QC station or QC Blow-off key on the M4500 keypad for quality verification.
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6) Restart Blow-offs: Thisisthe total number of cans blown off when the infeed opened and
from the print station and varnish station at machine restart.

7) Total Trips: Thisisthe total number of trips (sum of the individual trips per spindle) for the

shift.

8) Spindle #01 through #24: Thisisthetotal trips (mis-loads) for each spindle. A
disproportionately high count for a particular spindle indicates aloading problem for that

spindle.

Last Shift Data: The"Last Shift" dataisidentical to the current shift data except it isfor the
previous 8 or 12 hour shift or previous label run, however the shift collection is set-up. Thisallows
data collection and diagnostics to take place automatically over atwo shift period.

B RTFCD7? - [unnamed] - [Shift Data]

File Edit “iew ‘Window Help

Trips Per Spindle I Current Shift

—Last Shift

0.C. Blow-offs:

Fiestart Blow-offs:

Total Good Cans: [WST

Total Blow-offs: [W
Bad Can Blow-offs: [w_
tanual Blow-offs: [WB_

334
933

Total Trips: | 2 EEE

il |
=i T
w3 [ 121
w4 [ 80
g5 [ 33
g | 70
g7 [ 58
g3 [ B8
g3 [ 53
o [ 91
w1 [ 87
#z [ 143

wa[ =
w4 [ 181
w5 [ 115
we [ 13
wr [0
wa [ 84
wa [ @
w0 [ 81
w21 [0
#ez [ 198
w23 [ 85
toa [ 123

Systemn Mezzage: All Faults Marmal

| ONUME  [10/B/2003 | 440PM
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4.5.6 THE I/O STATES WINDOW

The “1/O States” window is provided to display states of the inputs and outputs. The control boards,
the states of the timing channels, as well as states of the M4500 are shown. Thisincludesthe
interrupt inputs (INO and IN1), the analog 1/O and the resolver. These values are displayed as read
by the M4500 processor.

H RTFCD7? - [unnamed] - [I/0 Status]

File Edit “iew ‘Window Help

~M4500 | Timing ~Slot)-0—— ~SlotD-1 ——— ~ Slot0-2
IND: off || CHOD: off [B100.0] 0 ON (B110.0] 0 ON [B1200] 0 off

INT: off || CHOT: off B1001] 1 off B1101] 1. off [B1201] 1. ON

CHOZ: ot [B100.2] 2 ON B110.2] 2 off B1202] 2 off

Analog [nput 0:- 0 CHOZ: O B100.3) 3 off B1103] 3 off 81203 3 OM
Analog Input 1: 0 CHO4: ON [B100.4) & ON 1104 4 off B120.4) 4 off

_ CHOS:  off [E1005) 5 off B110.5] 5 of [E1205] 5 ON

EAdo D s CHOE: it [BI00E) B off [B110E) & off [B120E) B oif

Sdhe Bl CHOF: ON BI007) 7 ON || B0 7 off [B1207) 7 ON

CH10: O [B101.0) 10 off [B111.00 10 aff [B121.0)0 10:  off

Resolver POS: 85 CH11: off [B101.1) 11: ON [B111.1) 11:  off B121.1) 11: 0N
Resobver RPM: 0 CH1Z off B101.2) 12 off || B11.2112 off || [B121.2) 120 OM
Resolver Period: 5000 || £y13 off B101.3) 1% off B111.3) 1% off B121.3) 13 off
Scale Factor 360 || £yi4 off (B101.4) 14:  off B111.4] 14 off (B121.4] 14 ON
Dffset: 333 || cHi5: off [B1015) 15 ON [B1115] 15 off [B1215) 15 off
CH1E: off [B1016) 16  off [B111.5] 16 off [B1216) 16 off
CH17: off B101.7) 17 off B111.7) 17 off [B121.7) 17 ON
Systemn Mezzage: All Faults Maormal OWNLINE ~ 10/6/2003 | 4:42PM 2
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section 2.10).

SECTION 5

HSLCD4 DOS BASED

SETUP PROGRAM REFERENCE

The DOS based "HSLCD4" set-up program is menu driven, allowing the user to easily view data,
alter set-up variables and set the machine timing (machine offset, timing signal locations, etc.) using
alaptop or personal computer. The set-up variables are used to configure and tune the HSLCDA4 to
match the configuration and performance of the specific decorator (see Tuning the HSL-CD4,

The main menu of the "HSLCD4" set-up program incorporates the following menu selections:

DI
Sustoms HSL-CDA Set-up Menu - Version 2.1

p R e B b D e

Kain Meno

SE".' Enrringef”urni:h FIES nnse TiIES
Sot Fin ChaindOC Eluu—nf¥ Parameters
Sot Wachine Timing

Wimber of trips per spindle data
Ciwrent Shift data

Last Shift data

Download Program to M&SHAS

Down 1 nad Set—ug data to HLSOS

Upload (Save) Set-up data from HESAS

Enter Selection (ESC to exit):

HOTE: Before selecting one of the nine =elections listed
dbove . connect an B%-237 cable from COM1 on the
conputer to the PROG PORT on the HMASHE.

Note: The"HSLCD4" program is an on-line communications program used to interface with the
M4500 module. The data displayed in the menus and set in the menus is communicated directly to
the M4500. Therefore, prior to selecting any of the above selections, make sure an RS-232 cableis
connected from the COM port on the computer running "HSLCD4" to the "PROG" port on the

M4500.

The following sections are a compl ete description of the "HSLCD4" selections and menus.
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5.1 SET CARRIAGE/VARNISH RESPONSE TIMES

The Carriage/Varnish Unit set-up menu is used to set the print carriage and varnish unit response
timesin the M4500. This menu isinvoked by selecting "1: Set Carriage/V arnish Response Times"
from the Main Menu. The menu selections on the "Print Carriage/Varnish Unit set-up” menu allow
the user to set the Carriage/VVarnish variables listed under the following menu selections:

To set aparticular variable, select the corresponding menu selection and follow the prompts as they
occur.

|0 =

Sustems HSL-CD& Set-up Wenu - Wersion 2.1

Print CarriagedVarnish Unit set-up
1: Set Print Carriage extend/retract response times

22 Set Varnizh Unit extendfretroct rezponze times
3 Set number of shifts to Yarnizh Unit

Enter Selection (ESC to emit): _

Print Carriage: )
Print Carriage retract response time (msecl. .. : 843
Print Carriage extend response time [m=zec).. ... : B&S

Yarnizh Unit:

Yarnizh Unit retract response time (msech. . ... : B&@
Yarnizh Unit estend response time Ensac} ....... ;. Bed
Humber of shifts to Varnish Unit ..............1 %

Note: Prior to selecting this selection, make sure the RS-232 cable is connected from the COM port
on the computer to the PROG PORT on the M4500.

Print Carriage retract response time: Thisisthe time used as the retract response time of the
carriage unit (time from solenoid actuation to first break with blanket) in milliseconds. The M4500
will activate the retract solenoid this amount of time ahead of the Carriage unit trip timing (CHOO)
(usually set at 40 to 50 milliseconds).

Print Carriage extend response time: Thisisthe time used as the extend response time of the
carriage unit (time from solenoid actuation to first contact with blanket) in milliseconds. The M4500
will activate the extend solenoid this amount of time ahead of the Carriage unit trip timing (CHOO)
(usually set at 40 to 50 milliseconds).
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Varnish Unit retract response time: Thisisthe time used as the retract response time of the
varnish unit (time from solenoid actuation to first break with varnish wheel) in milliseconds. The
M4500 will activate the extend solenoid this amount of time ahead of the Varnish unit trip timing
(CHO1) (usually set at 60 milliseconds).

Varnish Unit extend response time: Thisisthe time used as the extend response time of the
varnish unit (time from solenoid actuation to first contact with varnish wheel) in milliseconds. The
M4500 will activate the extend solenoid this amount of time ahead of the Varnish unit trip timing
(CHO1) (usually set at 60 milliseconds).

Number of Shifts to Varnish Unit: Thisisthe number of spindles from the Can Sensor to the
varnish unit minus 2. In general, thisis set such that the varnish unit retracts out on the can ahead of
the misloaded spindle. For older generation Rutherford Decorators, thisis set to "5". For newer
generation decorators, thisis set to "4".
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5.2 SET PIN CHAIN/QC BLOW-OFF PARAMETERS

The Pin Chain/QC Can Blow-off set-up menu is used to set the Pin Chain/QC Blow-off parameters
in the M4500. This menu isinvoked by selecting "2: Set Pin Chain/QC Blow-off Parameters' from
the Main Menu. The menu selections on the "Pin Chain/QC blow-off set-up" menu allow the user to
set the Pin Chain/QC Blow-off variables listed under the following menu selections:

To set aparticular variable, select the corresponding menu selection and follow the prompts as they
occur.

. CAHSLEDAAHSLCDA EXE

Suztems HEL-CO6 Set-up Menu - "l"ﬂ-siun 2.
Pim Chean/QC Blow-off sei-up

i-lof=|

Set Bad Can (pin chain) blow-off response times
Set number of cans to blow—off pin chain

Set numwber of pins to pin chain bhlow-off port
Setup 00 (select- blow-off

Enter Selection (ESC to ewit):
Pin Chain (Bad Can) Blow-off:

LAl gl

Blow-off solenoid “on” response time {msec) .. .; 615
Blow-off solenoid "of f7 response time (wmzec)... : 028
k of bad cans to blow-of f for mislead. ... ... . ..: 803
# of cans to blow-off from infeed open......... : BB6
# of cans to blow-off from print at restact. .. .: 004
I of cans to blow-off from varnish at restart..: 084
k of pins to pin chein blow—off port........... i
OC {=zelect-a-can) Blow-off:
Blow-off solencid “on” response time (msec)....: 915
Blow-off solenoid “off” response time (mzec)...: 020
OC can blow—off port shift offset..............; 8§01

Note: Prior to selecting this selection, make sure the RS-232 cable is connected from the COM port
on the computer to the PROG PORT on the M4500.

Bad Can Blow-off solenoid "on" response time: Thisisthe time used asthe "on" response
time of the pin chain blow-off port (time from "on" solenoid actuation to first air out port) in
milliseconds. The M4500 will activate the solenoid this amount of time ahead of the Pin Chain
blow-off timing (CHO5) (usually set at 15 to 20 milliseconds).

Bad Can Blow-off solenoid "off" response time: Thisisthe time used as the "off" response
time of the pin chain blow-off port (time from "off" solenoid actuation to air stopping at port) in
milliseconds. The M4500 will activate the solenoid this amount of time ahead of the Pin Chain
blow-off timing (CHO5) (usually set at 15 to 20 milliseconds for double acting solenoids and set at
25 to 30 milliseconds for single acting solenoids).

# of bad cans to blow-off for misload: Thisisthe number of cans blown off at the pin chain
port when one miss-loaded can is detected (typically set at 3 cans).
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# of cans to blow-off from infeed open: Thisisthe number of canswhich will be blown off
when the infeed isfirst opened. To blow off no cans at infeed open, set equal to 0O, to blow off one
can set equal to 1, etc.

# of cans to blow-off from print at restart: Thisisthe number of canswhich will be blown
off from the print station when the machine is restarted. To blow off no cans at restart, set equal to
0, to blow off one can set equal to 1, etc.

# of cans to blow-off from varnish at restart: Thisisthe number of canswhich will be
blown off from the varnish station when the machine is restarted. To blow off no cans at restart, set
equal to O, to blow off one can set equal to 1, etc.

# of pins to pin chain blow-off port: Thisisthe number of pinsfrom the spindle wheel to disk
transfer location to the first can blown off at the Pin Chain blow-off port minus two. This can be a
number from O to 999.

QC Can Blow-off solenoid "on" response time: Thisisthe time used as the "on" response
time of the QC blow-off port (time from "on" solenoid actuation to first air out port) in
milliseconds. The M4500 will activate the solenoid this amount of time ahead of the QC blow-off
timing (CHO6) (usually set at 15 to 20 milliseconds).

QC Can Blow-off solenoid "off" response time: Thisisthe time used as the "off" response
time of the QC blow-off port (time from "off" solenoid actuation to air stopping at port) in
milliseconds. The M4500 will activate the solenoid this amount of time ahead of the QC blow-off
timing (CHO6) (usually set at 15 to 20 milliseconds for double acting solenoids and set at 25 to 30
milliseconds for single acting solenoids).

QC Can Blow-off port shift offset: Thisisthe number of spindles difference from detection of
the spindle #1 flag to the QC blow-off port. Thisis anumber between 1 and 24 and is empirically
set by selecting spindle #1 for blow-off and adjusting this value until the can from spindle #1 isthe
can that is blown off.
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5.3 SET MACHINE TIMING

The Set Machine Timing selection is used to invoke the PL S programming

command menus (these

are the same menus used in SY Sdev to program the PL S section of the M4500).

" EAHSECDMVHSLE DS EXE

=loi=1

CDATHG

Program Hame:

eus F:rugr*arl Iﬁnuélﬂpumt - PL5dev (MESUR) Yersion &.2

Main Development Wenw

Online Channel Satpoint Programning
0ffline Channel Setpoint Programming
Edit PLS Configuration

Download Channels to PLS

Upload Channels from PLS

Print Channels

File Utilities

Return to S¥Sdeyv Shell

=l P STl T

12

Enter selection:

Note: Prior to selecting the Machine Timing selection, make sure the RS-232 cable is connected

from the COM port on the computer to the CHAN PORT on the M4500.

When selected, the PLS programming main development menu will be invoked using the default

CD4TMG channel set-point file.

=gl =]
CHANMEL - oy DESCRIPTION: Carriape Trip Timing |PROG MODE: ONLINE
CHAMMEL SET-POINTS
OH  DFF ON OFF ON  DFF ON  OFF ON DFF

1: A020-D0se 11 - 21 - 3 - &1 -

i - 12: - 22 - a2 - L -

5k = 13: = 24 = 33: = 43 =

[ = 14: 5 24t = I = i =

a2 % 15: = pibT = 35: = 0o -

G = 16: = il T = a6: = I o

i = 17: = il i = 37 = il =

8: = 18: = s = i i = LR -

q: - 19: - 29- - 39 - £9 - -
i - 20 - a8 - bz - 8 -

SCALE FRCTOR:368  ||MESSAGE. Fosition. 083  Speed(RPFM): 008

OFFSET -3 PULSE TRATH:NO ON:— OFF:— STRRT:——-

Hext | Prev |[Select] Doc Clear| Clear| P05/ | Set Fres

Chan | Chan | Chan Chan une |SetPnt| Chan | RPM 0ffzet] Menu
R e b g o R [orne st
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From this menu, the user can zero the machine (set the resolver offset) and adjust the timing signal
Set-points.

Note: Section 6 provides a complete description of each timing signal.

5.3.1 ZEROING THE MACHINE

To set the machine zero (resolver offset) perform the following:

1)

2)
3)

4)

5)

6)

7)

8)

Connect the RS-232 cable from the COM port on the computer to the "PROG" port on the
M4500.

Select the "3: Set Machine Timing" selection from the HSL-CD4 set-up program main menu.
Select "1: Online Channel Setpoint Programming” from the Main Development menu.

Select "F9: POS/RPM" and observe the "POS:" field. Verify that as the machine is rotated
forward (either jogging or barred) that the position increases linearly from 0 through 359. If not,
swap the S1 and S3 leads of the resolver at the M4500 resolver connector. Then verify that the
position then indeed does increase with forward movement. Press "ESC" to exit the "POS/RPM™
update.

Position the machine at machine zero (spindle aligned with V notch at top backside of machine
frame, see section 2.10.2 — Set Machine Zero).

Auto zero the resolver by selecting "F10: Set Offset”. Enter "0" in the offset field and press
<ENTER>.

The M4500 will calculate the actual offset value required to make this the 000 position and will
display this number in the offset field. The position will now read O.

Exit back to the PLS Main Development menu by pressing <ESC>. Exit back to the "HSLCD4"
set-up main menu by pressing <ESC> again.
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5.3.2 ADJUSTING THE TIMING CHANNEL SET-POINTS

To set or dter any of the timing signal set-points, perform the following:

1)

2)
3)

4)

5)

Connect the RS-232 cable from the COM port on the computer to the "PROG" port on the
M4500.

Select the "3: Set Machine Timing" selection from the HSL-CD4 set-up program main menu.
Select "1: Online Channel Setpoint Programming” from the Main Development menu.

Set al channels per section 6. Set-points are entered for a particular channel simply by typing in
the set-point in the form XXX-YYY<ENTER> in the first set-point of the given channel.

Note: Up to 50 set-points may be entered for any channel. However, for the decorator, only one
set-point is used per channel and should be entered in the number 1 set-point.

The XXX isthe location the set-point will turn "on" while YY'Y isthe location where the set-
point will turn "off". Use the PgUp, PgDn, F1:Next Chan, or F2: Prev Chan keysto select the
desired channel for programming.

Once al channels are programmed, press <ESC> to exit back to the PLS Main Development
Menu. Press <ESC> again to exit back to the "HSLCD4" set-up main menu. The new channels
will be saved both in the M4500 and in the "CD4TMG" file on the hard drive.
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5.4 NUMBER OF TRIPS PER SPINDLE DATA

The Number of trips per spindle menu is provided to aid in the trouble-shooting of aloading
problem with a spindle or spindles. The total number of trips for each spindle since the last reset or
end of shift is displayed. The operator can reset these counts at any time to aid in the trouble-
shooting process. In addition, the "Spindle Trip Offset" can be entered from this menu. Thisis used
to compensate for the location of the can/no can sensor and the spindle #1 1.D. sensor location.

When the "4: Number of Trips per Spindl€" selection is selected from the main menu, the total trips
per spindleis displayed and updated continuously in fields that read " Spindle #xx trips:" for each
spindle. To exit back to the main menu, press <ESC>. A disproportionately high count for a
particular spindle indicates aloading problem for that spindle.

. CAMSLCDAHSLEDS BXE . L =lai=|
Sustems HSL-CD& Set-up MWenu - Wersion 2.1
Trips per Spindle Henu
1: Set Spindle #1 trip offset

Z2: Reset Spindle trip counts

Enter Selection (ESC to ewit):
Spindle #1 trip offset: 08

Spindle HB1 trips: 36 spindle B13 trips: &
Spindle B2 trip=: 23 Spindle Hl& trip=: 15
Spindle HO3 trips: 10 Spindle W15 trips: 3
Spindle BOL trips: 9 Spindle K16 trips: 13
Spindle #OO trips: 2 Spindle ¥1T trips: 5
Spindle #06 trips: 1 Spindle #18 trips: 3
Spindle #B7 trips: & Spindle #17 trips: 4
Spindle BB8 trips: 1 Spindle #28 trips: 2
Spindle BOY trips: 2 Spindle #21 trips: 16
Spindle B1@ trips; & Spindle B2? trips: 29
Spindle M1l trip=: 14 Spindle W23 trip=: 7
Spindle H12 trip=: 11 Spindle B2 trip=: 19

Note: Prior to selecting this selection, make sure the RS-232 cable is connected from the COM port
on the computer to the "PROG" port on the M4500.

The menu selections on the "Trips Per Spindle" menu allow you to reset the trips per spindle counts
or set the "Spindle Trip Shift Offset. The selections are listed below:

1. Set Spindle #1 trip offset
2. Reset Spindle trip counts

To set the spindle trip offset, select "1" and enter the required offset (see section 2.10.11 — Set
Spindle Trip Shift Offset) and press <ENTER>. To reset the spindle trip counts, simply press"2".
The counts will be reset in the M4500. To exit back to the main menu, press <ESC>.
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5.5 CURRENT SHIFT DATA

The Current shift data menu displays the following information:

HELCDAVHELED

HE =loi=1

Sustems HSL-CD& Set-up MWenu - Wersion 2.1
Current Shift (Totals so farl
Prezz "ESC" to return to main meno:
Total Good Cans....: 400148 Total Blow-offs,...: 4169
Total Misloads.....: 2793 Reztart Blow-offs..: 258
Harnwal Blow-offs.,  : G40 i Blow-off=.....,.: 176
Spindle HA1 trips: 98 gpindle B13 trips; 29
Spindle WOA2 trip=: &3 Spindle Hl& trip=: &8
Spindle HO3 trips: &4 Spindle W15 trips: 33
Spindle HOL trips: 43 Spindle W16 trips: 46
Spindle 805 trips: 42 Spindle ¥17 trips: 31
Spindle #06 trips: 29 Spindle ¥1E trips: 20
Spindle #OT trips: 29 Spindle #17 trips: 47
Spindle HOE trips: 36 Spindle #20 trips: 32
Spindle HOF trips: 32 Spindle #21 trips: 58
Spindle #10 trips: 31 gpindle B2? trips: §1
Spindle W1l trip=: &7 Spindle H23 trip=: S0
Spindle H12 trip=: 5@ Spindle W2 trip=: 57

This dataisthe totals so far into the shift. Thisdataistransferred to the "Last shift" data when the
end of shift input transfersfrom a"0" toa"1". Thiscan be at the end of either an 8 or 12 hour shift
or aternatively could be done at label changes such that the data collected would be for label runs
rather than complete shifts. This data cannot be reset either from this menu or by the operator, only
at the end of shift input transition. To exit back to the main menu, press <ESC>.

Total Good Cans: Thisisthe total number of good cans printed so far into the shift. Thisis
essentially a can counter.

Total Blow-offs: Thisisthe total number of cans blown-off the machine. Thisincludes all types
of blow-offs: the three cans blown-off for every miss-loaded can, infeed open blow-offs, restart
blow-offs, manual blow-offs, select-a-can QC blow-offs, etc.

Total Mis-loads: Thisisthe total number of miss-loaded cans (trips). These would be the actual
number of damaged cans that did not load properly on the machine. This gives an indication of
conveying/can handling problems.

Restart Blow-offs: Thisisthe total number of cans blown off when the infeed opened and from
the print station and varnish station at machine restart.

Manual Blow-offs: Thisisthe total number of cans blown-off by the operator using the Manual
Blow-off PB or selector switch.
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QC Blow-offs: Thisisthe total number of cans blown-off by the operator with the Select-A-Can
QC station or QC Blow-off key on the HSL-CD4 keypad for quality verification.

Spindle #01 trips thru Spindle #24 trips: Thisisthe total trips (mis-loads) for each spindle. A
disproportionately high count for a particular spindle indicates aloading problem for that spindle.

5.6 LAST SHIFT DATA

The"Last Shift" dataisidentical to the current shift data except it isfor the previous 8 or 12 hour
shift or previous label run, how ever the shift collection is set-up. This allows data collection and
diagnostics to take place automatically over atwo shift period. Refer to section 5.5 — Current Shift
Datafor definitions of the data fields in the "Last Shift" data menu.

DAERE L. ==l =1
Sustems HSL-CD& Set-up MWenu - Wersion 2.1
Last Shift (Total for shift)
Prezz "ESC" to return to main meno:
Total Good Cans....: 765533 Total Blow-offs,...: 14113
Total Misloads.....: 969 Reztart Blow-offs..: 999
Harnwal Blow-offs.,  : 3024 i Blow-off=., ..., . : 390
Spindle HB1 trips: 229 gpindle B13 trips; 1§
Spindle HOA2 trip=: 122 Spindle Hl& trip=: 1851
Spindle #O3 trips: 121 Spindle W15 trip=: 115
Spindle HOL trips: 8@ Spindle W16 trips: 191
Spindle 805 trips: 99 Spindle W17 trips: 184
Spindle #06 trips: 70 Spindle ®18 trips: 84
Spindle #O7 trips: S8 Spindle #19 trips: 7@
Spindle HOE trips: 65 Spindle #20 trips: 81
Spindle HOP trips: 39 Spindle #21 trips: 119
Spindle #10 trips: 91 Gpindle W22 trips: 194
Spindle W1l trip=: &7 Spindle H23 trip=: BS
Spindle H12 trip=: 143 Spindle W24 trip=: 123
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5.7 DOWNLOAD PROGRAM TO M4500

This selection is used to download the HSL CD4 application program to the M4500 module. This
should only be performed when replacing the M4500 modul e (see section 2.11 —
M4500/P4500/D4591 Installation) or whenever changes have been made to the source code.

Note: Program download cannot be performed while the machine is running. All outputs are turned
"off" and no program execution is performed. Any miss-loaded cans will not be tripped for resulting
ininside litho.

To download the program, perform the following:

1) Connect the RS-232 cable from the COM port on the computer to the "PROG" port on the
M4500.

2) Select "7: Download Program to M4500". A prompt will be displayed asking to continue or
abort. To continue, press any key except the <ESC> key. To abort, press the <ESC> key. If a
prompt stating that the "HSLCD4.REV" file could not be opened is displayed, then the
"HSLCDA4" application program is not installed in the current directory. To install the program,
perform the steps in section 2.8.4 — Application Program Installation.

3) Once program download isinitiated, M4500 program execution will cease, the current address
being downloaded will be displayed, and the "RUN" LED on the M4500 will flash continuously.

4) Once the download is complete, the "RUN" LED on the M4500 will illuminate solid and
program execution in the M4500 will resume. Press any key to return back to the "HSLCD4"
main menu.

5.8 DOWNLOAD SET-UP DATA TO M4500

This selection is used to download the previously uploaded (saved) set-up variables to the M4500.
This should only be performed when replacing the M4500 module (see section 2.11 —
M4500/P4500/D4591 Installation).

Note: The set-up data consists of the carriage/varnish response times, pin chain/QC blow-off
parameters and the spindle trip shift offset. Timing channel set-points are not stored as part of the
set-up data. To download the set-up data, perform the following:

1) Connect the RS-232 cable from the COM port on the computer to the "PROG" port on the
M4500.
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2) Select "8: Download Set-up datato M4500". A prompt will be displayed asking to continue or
abort. To continue, press any key except the <ESC> key. To abort, press the <ESC> key.

3) Once datadownload isinitiated, the current address being downloaded will be displayed.

Note: Program execution is not ceased, therefore data download can be performed while the
machine is running.

4) Once set-up data download is complete, press any key to return to the "HSLCD4" main menu.

5.9 UPLOAD (SAVE) SET-UP DATA FROM M4500

This selection is used to save the set-up variables from the M4500 to the hard drive (current
directory selected). This should be performed anytime any of the set-up variables have been
changed.

Note: When the set-up variables are changed, they are changed directly in the M4500, not on the
filein the computer. By uploading (saving) the set-up variables to disk, they can be downloaded to
the M4500 in the event the module must be replaced. The set-up data consists of the
carriage/varnish response times, pin chain/QC blow-off parameters and the spindle trip shift offset.
Timing channel set-points are not stored as part of the set-up data. To upload the set-up data,
perform the following:

1) Connect the RS-232 cable from the COM port on the computer to the "PROG" port on the
M4500.

2) Select "9: Upload (Save) Set-up datafrom M4500". A prompt will be displayed asking to
continue or abort. To continue, press any key except the <ESC> key. To abort, press the <ESC>
key.

3) Once data upload isinitiated, the current address being uploaded will be displayed.

Note: Program execution is not ceased, therefore data upload can be performed while the
machine is running.

4) Once set-up data upload is complete, press any key to return to the "HSLCD4" main menu.
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The following isagenera description of the timing signals and the locations they should be set at:

CHOO0: PRINT CARRIAGE TRIP: Thissigna should just turn "on" when aspindleis at the
midpoint of a blanket. For abad can, the carriage is retracted midway of the can previous
to the bad can and extended midway on the can following the bad can. This signal should
be 40 degrees wide.

SPINDLE
WHEEL BLANKET

Location of Print Carriage Trip Timing
(CHOO — ON Set-point)

CHO1: VARNISH UNIT TRIP: Thissigna should just turn "on" when aspindle is centered on
the varnish wheel. For abad can, the varnish unit is retracted midway on the can previous
to the bad can and extended midway on the can following the bad can. This signal should
be 40 degrees wide.

VARNISH
ROLLER

Location of Varnish Unit Trip Timing
(CHO1 — ON Set-point)
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CHO2:

CHO3:

CHO4:

CHO5:

CHOG:

CHO7:

CH10:

CAN/NO CAN CLOCK: Thissignal is used to clock the bad can shift register which
activates the carriage, varnish, and pin chain blow-off for miss-loaded cans. It is aso used
as ageneral purpose clock for all shift registers, counters, etc. The can/no can clock is
generaly set "on" at 180 degrees and "off" at 000 degrees. The "off" to "on" transition of
CHO2 cannot however coincide with either the CHOO (Carriage trip), CHO1 (Varnish trip),
or CHO5 (Pin Chain Blow-off) timing signals. These timing signals must be set at least 30
degrees ahead or behind the CHO2 "off" to "on" transition.

DAMAGED CAN BLOW-OFF (LO) TIMING: Thissignal is used to activate the
damaged can blow-off solenoid at low speeds (below 1000CPM). The damaged can blow-
off "on" solenoid will actually be "on" for the duration of CHO3 when amiss-loaded can is
detected. Thissignal should be set "on" 10 degrees before air starts to leave the damaged
can port and set "off" 20 degrees before air stops leaving the port.

DAMAGED CAN BLOW-OFF (HI) TIMING: Thissignal is used to activate the
damaged can blow-off solenoid at high speeds (above 1000CPM). The damaged can blow-
off "on" solenoid will actually be "on" for the duration of CHO4 when a miss-loaded can is
detected. Thissignal should be set "on" 25 degrees before CHO3 turns "on™" and set "of "
50 degrees before CHO3 turns "of f".

Note: The can/no can sensor must normally first see agood can at least 30 degrees prior
to the "off" to "on" transition of CHO4, if not retard both CHO3 and CHO4 as necessary.
CHO4 isthe timing channel that actually clocks in the good can/bad can data from the
can/no can sensor.

PIN CHAIN (BAD CAN) BLOW-OFF TIMING: This should turn "on" when the chain
blow-off port is centered between pins on the chain (see section 2.10.4 — Set Pin Chain
Blow-off Timing). This signal should be 40 degrees wide.

QC (SELECT-A-CAN) BLOW-OFF TIMING: This should turn "on" when the select-a
can chain blow-off port is centered between pins on the chain (see section 2.10.4 — Set Pin
Chain Blow-off Timing). This signa should be 40 degrees wide.

CAN GATE TIMING: Thissignal is used to open and close the can gate. Set as necessary
for proper can gating.

PLC CLOCK TIMING: Thissignal is provided to the PLC viaadiscrete DC output. This
is used for whatever purpose required by the host PLC to clock once per spindle data. In
general this should be set "on" for 180 degrees and "off" for 180 degrees. Otherwise set as
desired. Thissignal is not used by the HSL-CD4 package internally in any way.
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The following are recommended spares for the HSL-CD4. These parts are available through
Systems Engineering Assoc. Inc.

Quantity Part Number Description

lea M4500 PLC/PLS Processor/Chassis — 4 Slot
lea. P4500 Power Supply

lea. 4563 16 Point 10-30VDC Input Board

lea. 4568 8 input/8 output 10-30VDC I/O Board
lea. 4573 16 point 10-30VDC Output Board
lea. D4591 Display/Keypad
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MODBUS PORT CONFIGURATION

The MODBUS driver uses the following data format and parameters (the MODBUS port on the
MODICON PLC must be set to match these):

MODBUS Port (PLC address): 5
MODBUS Baud: 19.2K
MODBUS framing mode: RTU
Number of start bits: 1
Number of data bits: 8
Number of stop bits: 1
Parity: NONE

The MODBUS communications driver uses the S4516 communications board to both read and write
datato aMODICON PLC.

DATA WRITTEN TO THE MODICON PLC

The following data is written to the MODICON PLC:

MODICON Dest. M4500 Source
4x Address Data Definition Address
401700 Speed (CPM) w182
401701 Resolver Position W180
401702 Number of Good Cans (L0o-0 to 9,999) W1100
401703 Number of Good Cans (Hi-10,000's) w1102
401704 Tota Blow-offs (Lo-0 to 9,999) W1104
401705 Tota Blow-offs (Hi-10,000's) W1106
401706 Total Misloads W1108
401707 Restart Blow-offs W1112
401708 Manual Blow-offs W1116
401709 QC (select-a-can) Blow-offs W1120
401710 Trips per Spindle #1 (for Shift) W1124
thru thru thru
401733 Trips per Spindle #24 (for Shift) W1170
401734 Trips per Spindle #1 (Diagnostics) w1020
thru thru thru
401757 Trips per Spindle #24 (Diagnostics) W1066
401758 Status (to MODICON) W690
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The definitions of the data sent from the M4500 to the MODICON are as follows:

401700:

401701:

401702:

401704:

401706:

401707:

401708:

401709:

401710:

401734:

Speed - Current strokes per minute of the cupper
Resolver Position - Current angular position of the cupper crankshaft (in degrees)

Number of Good Cans - Thisisthe total number of good cans printed so far into the
shift. Thisis essentially a can counter.

Total Blow-offs - Thisisthe total number of cans blown-off the machine. This
includes all types of blow-offs: the three cans blown-off for every miss-loaded can,
infeed open blow-offs, restart blow-offs, manual blow-offs, select-a-can QC blow-
offs, etc.

Total Midloads - Thisisthe total number of miss-loaded cans (trips). These would be
the actual number of damaged cans that did not load properly on the machine. This
gives an indication of conveying/can handling problems.

Restart Blow-offs - Thisis the total number of cans blown off when the infeed
opened and from the print station and varnish station at machine restart.

Manual Blow-offs - Thisisthe total number of cans blown-off by the operator using
the Manual Blow-off PB or selector switch.

QC (select-a-can) Blow-offs - Thisisthe total number of cans blown-off by the
operator with the Select-A-Can QC station or QC Blow-off key on the HSL-CD4
keypad for quality verification.

Trips per Spindle #1-#24 (for Shift) - Thisisthe total trips (mis-loads) for each
spindle so far into the current shift. A disproportionately high count for a particular
spindle indicates aloading problem for that spindle.

Trips per Spindle #1-#24 (Diagnostics) - Thisisthe total trips (mis-loads) for each
spindle. These counts can be reset by the operator whenever desired. A
disproportionately high count for a particular spindle indicates aloading problem for
that spindle.
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Status register (to the MODICON from the M4500) are mapped as follows:

W690: Status to MODICON (4x address 401758 in MODICON)

B690.0:
B690.1.
B690.2:
B690.3:
B690.4.

thru

B691.7:

Zero Speed

Infeed Track Jam Alarm
Transfer Jam Alarm
Timing Signal Fail Alarm
Not Used

Not Used

The Status bits sent to the MODICON PLC are defined as follows:

B690.0:  Zero Speed - Thishit isset to a"1" when the decorator speed is below 30CPM. This
bit is set to a"0" when the speed is greater than 30CPM.

B690.1: Infeed Track Jam Alarm - The infeed track jam alarm occurs when 6 consecutive
empty mandrels are detected by the can/no can sensor after the can gate is opened.

B690.2: Transfer Jam Alarm - The no can transfer alarm occurs when the no can transfer
sensor detects a can on amandrel after the disk transfer location.

B690.3: Timing Signal Fail Alarm - The timing signal fail occurs when any of the timing
signals generated in the PL S section fail to change state periodically while the
machine is running.
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DATA READ FROM THE MODICON PLC

Thefollowing datais read from the MODICON PLC:

MODICON Dest. M4500 Source
4x Address Data Definition Address

401760 Status/Control (from MODICON) W900
401761 CHO0 "On" - Carriage Trip Timing W902
401762 CHQO "Off" - Carriage Trip Timing W04
401763 CHO1"On" - Varnish Trip Timing W906
401764 CHO1 "Off" - Varnish Trip Timing W908
401765 CHO02 "On" - Can/No Can Clock Timing W910
401766 CHO2 "Off" - Can/No Can Clock Timing W912
401767 CHO03"On" - Damaged Can Blow-off (Lo) W9o14
401768 CHO3 "Off" - Damaged Can Blow-off (L0) W916
401769 CHO4 "On" - Damaged Can Blow-off (Hi) Wo18
401770 CHO4 "Off" - Damaged Can Blow-off (Hi) W920
401771 CHO5"On" - Pin Chain Blow-off Timing W922
401772 CHO5 "Off" - Pin Chain Blow-off Timing w924
401773 CHO6 "On" - QC Blow-off Timing W926
401774 CHO6 "Off" - QC Blow-off Timing W928
401775 CHO7 "On" - Can Gate Timing W930
401776 CHO7 "Off" - Can Gate Timing W932
401777 Print Carriage Retract Response Time W934
401778 Print Carriage Extend Response Time W936
401779 Varnish Unit Retract Response Time W938
401780 Varnish Unit Extend Response Time W940

Bad Can (Pin Chain) Blow-off:
401781 Blow-off Solenoid "On" Response Time W42
401782 Blow-off Solenoid "Off" Response Time Wo44
401783 # of bad cansto blow-off for misload W946
401784 # of cans blow-off from infeed open Wo48
401785 # of cans blow-off from print at restart W950
401786 # of cans blow-off from varnish at restart W952
401787 # of pinsto pin chain blow-off port W954

QC Can (Select-a-can) Blow-off:
401788 Blow-off Solenoid "On" Response Time W956
401789 Blow-off Solenoid "Off" Response Time W958
401790 QC can blow-off port shift offset W960
401791 Spindle Trip Offset W962
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The definitions of the data read from the MODICON to the M4500 are as follows:

401761:
thru
401776:

401777:

401778:

401779:

401780:

401781

CHO0 "On" - Carriage Trip Timing

CHO7 "Off" - Can Gate Timing

Variables 401761 thru 401776 are the "On" and "Off" timing set-points for CHOO
thru CHO7 respectively. This allows the MODICON to program these timing
channels when the "Timing Channel Program Enable" bit (401760.3 from the
MODICON) issettoa"1". These are the same "On" and "Off" set-points that would
normally be set through the HSL-CD4 keypad (see section 3.5.3 — Set Machine
Timing) or set through the HSL CD4 set-up program (See section 4.5.4 —The
Machine Timing Window or section 5.3 — Set Machine Timing). See section 6 for
the definitions of the CHOO through CHO7 timing channels.

Print Carriage Retract Response Time - Thisis the time used as the retract response
time of the carriage unit (time from solenoid actuation to first break with blanket) in
milliseconds. The M4500 will activate the retract solenoid this amount of time ahead
of the Carriage unit trip timing (CHOO) (usually set at 40 to 50 milliseconds).

Print Carriage Extend Response Time - Thisis the time used as the extend response
time of the carriage unit (time from solenoid actuation to first contact with blanket)
in milliseconds. The M4500 will activate the extend solenoid this amount of time
ahead of the Carriage unit trip timing (CHOO) (usually set at 40 to 50 milliseconds).

Varnish Unit Retract Response Time - Thisis the time used as the retract response
time of the varnish unit (time from solenoid actuation to first break with varnish
wheel) in milliseconds. The M4500 will activate the extend solenoid this amount of
time ahead of the Varnish unit trip timing (CHO1) (usually set at 60 milliseconds).

Varnish Unit Extend Response Time - Thisis the time used as the extend response
time of the varnish unit (time from solenoid actuation to first contact with varnish
wheel) in milliseconds. The M4500 will activate the extend solenoid this amount of
time ahead of the Varnish unit trip timing (CHO1) (usually set at 60 milliseconds).

Blow-off Solenoid "On" Response time - Thisis the time used as the "on" response
time of the pin chain blow-off port (time from "on" solenoid actuation to first air out
port) in milliseconds. The M4500 will activate the solenoid this amount of time
ahead of the Pin Chain blow-off timing (CHO5) (usually set at 15 to 20 milliseconds).
Valid range: 5 to 60 msec.
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401782:

401783:

401784:

401785:

401786:

401787:

401788:

401789:

401790:

Blow-off Solenoid "Off" Response time - Thisis the time used as the "off" response
time of the pin chain blow-off port (time from "off" solenoid actuation to air stopping
at port) in milliseconds. The M4500 will activate the solenoid this amount of time
ahead of the Pin Chain blow-off timing (CHO5) (usually set at 15 to 20 milliseconds
for double acting solenoids and set at 25 to 30 milliseconds for single acting
solenoids). Valid range: 5 to 60 msec.

# of bad cansto blow-off for misoad - Thisisthe number of cans blown off at the
pin chain port when one miss-loaded can is detected (typically set at 3 cans).

# of cans blow-off from infeed open - Thisis the number of cans which will be
blown off when the infeed is first opened. Valid range: 0 to 99.

# of cans blow-off from print at restart - Thisis the number of cans which will be
blown off from the print station when the machine is restarted. Valid range: O to 99.

# of cans blow-off from varnish at restart - Thisis the number of cans which will be
blown off from the varnish station when the machine is restarted. Valid range: O to
99.

# of pinsto pin chain blow-off port - Thisisthe number of pinsfrom the spindle
wheel to disk transfer location to the first can blown off at the Pin Chain blow-off
port minus two. This can be a number from O to 999.

Blow-off Solenoid "On" Response time - Thisis the time used as the "on" response
time of the QC blow-off port (time from "on" solenoid actuation to first air out port)
in milliseconds. The M4500 will activate the solenoid this amount of time ahead of
the QC blow-off timing (CHO6) (usually set at 15 to 20 milliseconds). Valid range: 5
to 60 msec.

Blow-off Solenoid "Off" Responsetime - Thisis the time used as the "off" response
time of the QC blow-off port (time from "off" solenoid actuation to air stopping at
port) in milliseconds. The M4500 will activate the solenoid this amount of time
ahead of the QC blow-off timing (CHO06) (usually set at 15 to 20 milliseconds for
double acting solenoids and set at 25 to 30 milliseconds for single acting solenoids).
Valid range: 5 to 60 msec.

QC can blow-off port shift offset - Thisisthe number of spindles difference from
detection of the spindle #1 flag to the QC blow-off port. Thisis anumber between 1
and 24 and is empirically set by selecting spindle #1 for blow-off and adjusting this
value until the can from spindle #1 is the can that is blown off.
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Spindle Trip Offset - Thisisthe number of spindle difference from the detection of
the spindle #1 flag to the Can/No Can sensor. Thisis a number between 0 and 23 and
isempirically such that a miss-loaded can on spindle #1 increments the spindle #1
count in the "Trips per spindle’ menu.

Note: The above parameters (401777 thru 401791) are effective only when the " Set-Up Parameters
Enable" bit (401760.2 from the MODICON) isset to a"1". Otherwise, these variables are not
updated in the M4500.

The bits of the Status/Control register (from the MODICON to M4500) are mapped as follows:

W900: Status/Control from MODICON (4x address 401760 in MODICON)
B900.0: End of Shift
B900.1: Spindle Trip Reset
B900.2: Set-Up Parameters Enable
B900.3: Timing Channel Program Enable
B900.4: Set Resolver Zero (Auto-Zero)
B900.5: Alarm Reset
B900.6: Not Used

thru

B901.7: Not Used

The Status/Control bits sent from the MODICON PLC are defined as follows:

B900.0:

B900.1:

B900.2:

End of Shift - Setting thishit toa"1" transfers the current shift data in the M4500 to
the last shift data and clears the current shift data (to start data collection for the next
shift). The current shift datain the MODICON should be saved to the last shift data

stack prior to setting this bit.

Spindle Trip Reset - Setting thisbit to a"1" resets the "Trips per Spindle #1 - #24"
counts stored in MODICON 4x variables 401734 thru 401757.

Set-Up Parameters Enable - Setting thisbit to a"1" enables the set-up parameters
(401777 thru 401791 in the MODICON) to be used in the M4500. If thisbit is set to
a"0", thevaluesin 401777 thru 401791 in the MODICON are not used as the set-up
parameters, the M4500 instead uses the values set-up thru the HSL-CD4 keypad or
the "HSLCD4" set-up program.
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B900.3:

B900.4:

B900.5:

Timing Channel Program Enable - Setting this bit to a"1" enables the CHOO thru
CHO7 "On" and "Off" set-points (401761 thru 401776) from the MODICON to be
used as the set-points for CHOO thru CHO7 in the PLS section of the M4500. If this
bitissettoa"0", the valuesin 401761 thru 401776 in the MODICON are not used as
the set-points, the M4500 instead uses the values set-up thru the HSL-CD4 keypad or
the "HSLCD4" set-up program.

Set Resolver Zero (Auto Zero) - Setting this bit sets the PL S offset such that the
current position is"0". To set the resolver zero, position the machine at machine zero
and then set thisbit to a"1". The resolver position will now read 000. Reset this bit
back to "0" when done,

Alarm Reset - Setting thisbit to a"1" resets the Infeed Track Jam alarm, Transfer
Jam alarm, and the Timing Signal Fail alarm.
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DF1 COMMUNICATIONS

HARDWARE

DF1 communication takes place viathe Channel O port of the Allen Bradley PLC. The RS-232 cable
should be constructed and connected as shown below:

S4516-DF1 to PLCS

SLOT 0-3
SW1 Sw2

ON ON e

$4516-DF1
COMMUNICATIONS
CO-CPU

CHO
25—PIN

X

RX

SG

RTS
CTs

DSR
DCD
DTR

o

(&
N O N e N

S3000 NETWORK
COMMUNICATIONS
(IF USED)

"’_\r‘>
i

Internally, the PLC-5 should be set up for RS-232C communication. Refer to the dip-switch settings
guide on the side of the processor.

Note: The $4516-DF1 should be switched for RS-232 communication.

Dip switch SW1 isthe RS-232/RS-422 dip switch should be set to:
POLE 1=0ON
POLE 2 = OFF

Dip switch SW2 isthe slot address, and is dependent upon the rest of the cards in the M4500
rack. For the HSL-CD4 or HSM-CD?7 control system, SW2 should be set to slot 0-3:

POLE 1=0ON

POLE 2=0ON
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S4516-DF1to SLC

SLOT 0-3
SW1 sw2
Hu ON H ON
SLC500
S4516-DF1 9C—HP(\)N
COMMUNICATIONS
CO—CPU 1
R —
RXD O —+t H— 2 | RX
Il |
Rszszﬂ XD 1 —H H— 3| T
Il |
SG 2 —H H— 5] s6
o

RXD+ 4
RXD— 5 7| RTS
RS—422 8 | CTs
TXD+ 6
TXD— 7
-]
r——A

S3000 NETWORK
COMMUNICATIONS
(IF USED)

‘ "/—\‘—l>
Y | .
|2

|

[}

|

l's 4
L__1

S4516-DF1 to ControLogix

CONTROLOGIX
SLOT 0-3 s 0%
SW1 sw2 [SERIAL PORT]
ON ON 9—PIN
1| DCD
S4516-DF1
COMMUNICATIONS E 4] PR
CO-CPU DSR
[ la] (e}
| RXD O H H— 2 | RX
| I \
: RS-232 H XD 1 + }% 31X
I Il
: SG 2 H i 5| s6
: 3 AJLAAAAAAAAAAAAAALT[:: 7 | RS
: RXD+ 4 8|cms
|
| RXD— 5
|RS—422
| XD+ 6
|
| ™XD— 7
P |
-
\ S3000 NETWORK
| COMMUNICATIONS
| — 11—t [ (F Usep)
\
|+ 2
\
-3
\
l's 4
L=
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SOFTWARE

PLC5
The following sample RSLogix5 code is used to execute the message control function to allow a
PL C5 processor to communicate with the $4516-DF1 serial communications board.

! #bkohk 54516-DF] SERTAL COMMUNICATIONS #htr
|- Execute M3G Instruction EeadWinte Messagzes --
54518-DF1 M35
Commmmications Instraction EEAD DATA 1
Reset Hurher (34516-DF1)
T40 EQT ——MEG
0ooo = -E Equal Fead Write Messaze |—(EH )
TT Source & H7:0 Contrcl  MG200 —CDH 32—
0= Setap Screen = —C:ER:)—
Soaree B o
0=
M35
Instrction READ DATA 2
Hurher [54516-DF1)
EQT MG
Equal FeadWrite Messaze |—(EN }—
Source & 170 Control  MG20:1 [—CDH 33—
0= Setap Sereen = —[':ER:]—
Soarce B 1
1=
M35
Instruction WRITE DATA 1
Mumher (54516-DF1)
EQU M3G
Equal Fead Write Messaze |—( BN }—
Source A M70 Control  MG20:2 D 3—
0= Setup Screen = L ER 3—
Source B 2
2=
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-- Increment to HEXT MG Instmetion --
- The "Done" bat (D) is set when the last packet of the message is mecessfully transferred.
- The "Error" bit (EE] 15 set when the controller detects that a transter failed.
M3G Instmcion MG
READ DATA 1 READ DATA 1 - DONE Instmction
[54516-DF1) (One Shat) Humber
MG20:0 B30 A0
oooL 1 E [[ons 7] Add
DH 1] Sonrce 4 W70
0=
FEAD DATA 1 Somree B 1
[34516-DF1) 1=
MiG20:.0 Diest H70
1 E 0=
ER
MEG Instmcion
READ DATA 2 READ DATA 2 - DONE
[54516-DF1) (One Shat)
MF20:1 B30
T E {ons |
DH 1
FEAD DATA 2
[34516-DF1)
MG20:1
5 Y
5 ]
ER
MEG Instrucion
WEITE DATA 1 WEITE DATA 1 - DONE
[34516-DF1) [Cne Shat)
BIG20:2 B30
3 E {ows ]
DH
WEITE DATA 1
[34515-DF1)
BIG20:2
=
xR e
ER
-- Eoll-over MSG Instraction Humber —-
MG MEG
Instmction Instruction
Hhober Hunther
GRET MOV
onoz Greatey Than (A=F) Moave
Somrce 4 W70 Sonree 0
0= 0=
Senrce B i Diest W70
2= 0=
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-- 34518-DF] Serial Comnmnications Feset --
£4518-DF1
FEAD DATS 1 Commoinications
[54514-DFL) Resat
K200 TON
ooa3 A Tirmer On Delay - EN 33—
ER Timer T4.0
Time Base 10 DE—
READ DATA 2 Preset 352
[54516-DF1) Aeoum 0=
MG20:1
g
2 L
ER
WEITE DATA 1
[54516-DFL)
MG20:2
SFE
es [
ER
34515-DF1
Conmmnucations
Feset
T4:0
I 'E
pr o
TT
-- Eeset MEG Instruction Errors -
54518-DF1
Cormnmrications READ DATA 1
Feset (54516-DF1)
T4:.0 MG20:0
oo ] E i
jni) ER
FEEADDATA 2
[54516-DFL)
KIG20:1
T
Rung 2:0004 ER
WEITE DATA 1
(54515-DF1)
MG20:2
i
ER
o005 END 3—
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SLC500

The following sample RSL ogix500 code is used to execute the message control function to allow a
SL.C500 processor to communicate with the $4516-DF1 serial communications board.

etttk 24516-DF] SERTAL COMMUNICATIONS st
- Execute MG Instraction Fead Write Massages --
S4518-DF1 MEG
Cormmmirications Instruction READ DATA 1
Reset Humber (54518-DF1)
T4:0 EQU MG
0o0a = Equal FeadWrite Message L EH
ALK Sonrce & N0 Type Peer-To-Peer
0= Fead/Write Fead (DN T—
Soarce B 1] Target Device S00CPT
0= LocalRemote Local —[:ER:]—
Caontral Block Wlz.0
Control Block Length 14
Setup Screen =
MEG
Instruction READ DATA 2
Humber (54518-DF1)
EQT —DMIiG
Equal Read/Write Massage I EH
Sonroe & 70 Type Pear-Tao-Paer
0= ReadWrite Fead (DN 3—
Sonrce B 1 Target Device S00CPTT
1= LocalFemote Local [ ERT—
Control Block H12:20
Ceantral Black Length 14
Setup Screen 2
MIG
Instruction WEITE DATA 1
Humber (54518-DF1)
ECQT —MEG
Equal Fead/Write Messaze I (EH )
Source & 70 Type Peer-To-Peer
0= Fead/Write Write |—(DN—
Searrce B 2 Target Device S00CPT
2= LocalFemote Loecal —[:ER:]—
Contral Black H12:40
Control Block Length 14
Setup Soreen =
-- Incrament to HEXT MG Instmetion --
- The "Done" bit (.13 5 set when the last packet of the messaze is mccessflly transferred.
- The "Error" bit [.12] is set when the controller detects that a transfer failad.
READ DaTa 1 M3G Instrucion M3G
DONE READ DATA 1 - DONE Instmction
(54518-DF1) [One Shot) Humber
Wlz2:0 B3:0 AT
ooal ] E [0sE ] 4dd
153 u] Somrce 4 H7.0
0=
READ DATA 1 Senrce B 1
ERROR 1=
(54518-DF1) Diest W70
Wlz.0 0=
J E
= k] ey
12
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-- Roll-over MSG Instraction Hawber --
FEAD DATA 2 MEG Instrucion MG
DONE READ DATA 2 - DONME Instmetion
(54518-DF1) (One Shat) Humber
wWlz:20 B30 ATD
0002 J E [osR ] Add
15 1 Sonrce 4 H7.0
0=
READ DATA 2 Somrce B 1
ERROR 1=
(54518-DF1) Diast W70
Wlz:z0 0=
qE
gl Dl
12
-- Roll-over MSG Instraction Hawber --
WERITE DATA 1 MEG Instrucion MG
DONE WEITE DATA 1 - DONE Instmetion
(545158-DF1) (One Shat) Humber
Wlz2:40 B3:.0 A0
0003 ] E [ o3k ] Add
13 2 Sonrce 4 H7.0
0=
WERITE DATA 1 Somrce B 1
ERROR 1=
(54518-DF1) Diast W70
Wl1z2:40 0=
e
el el
12
-- Roll-aver MSG Instraction Hamwber -
MG MIG
Instmection Instrction
Humber Hurmber
GRET MOV
Qo4 Greater Than (4=F) Moaove
Source 4 M0 Sonroe 0
0= 0=
Sonrce B 2 Diest N0
2= 0=
-- 24518-DF] Seral Commmnications REeset --
READ DaTa 1 S4516-DF1
ERROR Comnmarications
(54518-DF1) Reset
Wlz2.0 TOH
0005 ] E Timer On Delay —EH 53—
12 Titner T4:0
Time Base 1.0 —CDN:I—
READ DATA 2 Preset 35
EFROR Aommm 0=
(54518-DF1)
Wlz:20
] ol I
el
12
WEITE DATA 1
ERROR
(54518-DF1)
Wlz2:40
=
d =
12
24516-DF1
Comnmrications
Feset
T4:.0
b =
= P
HEE
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-- Resat MSG Instmction Exvors --
54516-DF1
Commmnications
Raset

4

FEAD DATA 1

ERROR

(54516-DF1)
W12:0

mo

00oa

-

H

ooa?

i
12

READ DATA 2
ERROE
(34516-DF1)
H12:20
i |
12

WEITE DATA 1
ERROR
(34516-DF1)
W1z:40
iy
12

{END ™
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ControlLogix and CompactLogix

APPENDIX B
DF1 COMMUNICATIONS

The following sample RSL ogix5000 code is used to execute the message control function to allow a
ControL ogix or CompactLogix processor to communicate with the S4516-DF1 serial

communications board.

fFrrxet SAST6-DF1 SERIAL COMMMICATIONS ===
- Execute MSG Instruction Read SWirite Messages
S4516-DF
Communications MSG Instruction READ DATA 1
Reszet Mumber (=4516-0F1)
COMM_TOTT ECL e
] /' Exjual Mezzage HCEM
Source & maghium Message Control magRead? D LD —
0 e L CER—
Source B 1]
MEG Instruction READ DATA 2
Mumber (S4516-DF1)
ECILI e
Enqual Mezsane BN —
Source & maghlum Mezzage Control msgRead2 E! D —
0 L CER—
Source B 1
MSG Instruction WWRITE DATA 1
Mumber (S4516-DF1)
ECLI e
Eqjual Meszsage - B —
Source & maghlum Meszage Control magiite D Dk —
0e HER 3 —
Source B 2
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k- Increment to MEXT MSG Instruction --
- The "Done” bit (D) iz set when the last packet of the message iz successfully transferred.
- The "Error" bit (ER] iz =&t when the contraller detects that atransfer failed.
MZG Instruction
READ DATA 1 READ DATA 1 - Done MG Instruction
(54516-DF 1) [One Shot) Mumber
magRead! DN megRead! _ONS aln
1 ] [ [ONS] gdd : .
READ DATA 1 rebadast Ll
(SR EREI Source B 1
magRead ER
4] Dest mEgum
0 €
MZG Instruction
READ DATA 2 READ DATA 2 - Done
(54516-DF1) [Tne Shot)
msgRead2. DN megRead2_ONS
£ i [N ]
READ DATA 2
(=4516-DF1)
msgRead2 ER
M= Instruction
WRITE DATA WRITE DATA 1 - Done
(=4516-DF1) [Cne Shot)
megyrite] DR magyrite] _ONS
1k {ONE ]
WRITE DATA
(S4516-DF1)
meg\yrite] ER
MG Instruction MSG Instruction
Mumber Mumber
GRT Ry
2 Greater Than (&=0) Miove
Source & maghlum Source i
0 &
Source B 2 Dest maghum
0 &
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- 34516-DF1 Serial Communications Reset --
S4516-DF1
READ DATA 1 Cominunications
[S4516-DF 1) Rezet
msgRead] ER TN
3 1 F Timer On Delay HCEM ——
Timer  COMM_TO
FHERDIEET A Preset 35000 € DN —
[=54316-DF 1) Accum 0 &
msgRead2 ER
e
1 C
WRITE DATA 1
(=4516-0F 1)
msgrite1 ER
1E
i
S4516-0F1
Communications
Reset
COMM_TOTT
Fo
il
S4516-DF1
Communications READ DATA 1
Reset [=4516-DF1)
COM_TO DM mzgRead! ER
4 1 E il
READ DATA 2
[S4516-DF 1)
msgRead2 ER
i)
WRITE DATA 1
[S4516-DF 1)
megyrite1 ER
—
(Enc)
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USING THE MSG INSTRUCTION

READ INSTRUCTION — PLC5
The read message (M SG) command for a PLC5 is setup as follows:

5 MSG - MGZ0:0 ; (1 Elements) = =IOl x

- This PLC5 ~ Conbral Bits——————————
Commuriication Command : [51C Typed Logical Fead | lgnore if timed out (T0): [0 ]
Data T able Address : @ To be retried [MR]: E
Size in Elements : E Aumaiting Esecution [EW): E
Port Mumber: El Continuous Run [CO): E
- Error [ER): E
- Target Device tessage done (DNJ: [0 |
Data Table Address: Message Transmitting [ST): E

Local Station &ddress (oct): [dec): Message Enabled [EN); E
Local A Remote :

— Error

Error Code(Hex): 0

— Errar Description

Mo ermars

1 MSG - MG20:1 : {1 Elements) i -0l x|

— This PLC-5 — Comtral Bitg——————————————
Commuriication Command : [$LC Typed Logical Read | Ignore if timed aut (T0): [0 ]
Data Table Address : [N10.100 Ta be retried [MR): [0 ]
Size:in Elements : duwaiting Execution [Ew: [0]
Paort Humber: El Continuous Fun [CO): E
) Error [ER): E
- Target Device Message done [DN); E
Data Table Address: Message Transmitting [3T): [0 ]
Local Station Address [oct]: [dec): Message Enabled [EN): E

Local # Remate ;

— Ermor

Error Code[Hex): O

Error Description
’V No ermors

Note: The*Communication Command” is SLC Typed Logical Read. The Data Table Address can
be any integer file address. The 150 elements (total) read from the M4500 PLC are defined in the
last section — Read/Write Data Definitions.
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The Local Station Addressis only necessary to define if communications with the S4516-DF1 is
executed over a Data Highway network (viaa Datalink Module).

WRITE INSTRUCTION — PLC5
The write message (M SG) command for a PLC5 is setup as follows:

2 MSG - MG20:2 : (1 Elements) o ]

- This PLC5 ~ Conbral Bits——————————
Communication Command : [51 T Typed Logical Wiite | lgnore if timed out (T0): [0 ]
Data T able Address : @ To be retried [MR]: E
Size in Elements : E Aumaiting Esecution [EW): E
Port Mumber: El Continuous Run [CO): E
- Error [ER): E
- Target Device tessage done (DNJ: [0 |
Data Table Address: Message Transmitting [ST): E
Local Station Address [oct]: [dec): Message Enabled [EN): E

Local A Remote :

— Error

Error Code(Hex): 0

— Errar Description

Mo ermars

Note: The“Communication Command” is SLC Typed Logical Write. The Data Table Address

can be any integer file address. The 10 elements written to the M4500 PL C are defined in the last
section — Read/Write Data Definitions.
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READ INSTRUCTION — SLC500
The read message (M SG) command for a SLC500 is setup as follows:

5 MSG - N12:0: {14 Flements) =10l x|
Thiz Contraller rControl Bits————————————
Communication Command: |5DDCPU Bead | lgnare if imed out [TO): E
Data Table Address: @ To be retried [MR]: IE
Size in Elements: E Awaiting Execution [E4]: m
Channel:: EI Continuouz Run [COJ: m
} Emor [ER): @
- Target Device Message done [DN): [0]
Message Timeout : Message Transmitting (ST): [0 ]
Data Table Addiess: Message Enabled (EN]: [0 ]

Local Node Addr (dec): [octal) Wating for Queve Space :[1]
Laocal 4 Remote :

—Errar

Error Code[Hex): O

Eror Dezcription
’7 MNa ermors

55 MSG - N12:20 : (14 Elements) =10l x|
Thiz Contraller rControl Bits————————————
Communication Command: |5DDCPU Bead | lgnare if imed out [TO): E
Data Table Address: ml To be retried [MR]: IE
Size in Elements: E Awaiting Execution [E4]: m
Channel:: EI Continuouz Run [COJ: m
} Emor [ER): @
- Target Device Message done [DN): [0]
Message Timeout : Message Transmitting (ST): [0 ]
Data Table Addiess: Message Enabled (EN]: [0 ]

Local Node Addr [dec): [octall Waiting for Queve Space: [0]
Laocal 4 Remote :

—Errar

Error Code[Hex): O

MNa ermors

" Eror Dezcription

Note: The Data Table Address can be any integer file address. The 150 elements (total) read from
the M4500 PLC are defined in the last section — Read/Write Data Definitions.

The Local Station Addressis only necessary to define if communications with the S4516-DF1 is
executed over a Data Highway network (viaa DatalLink Module).
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WRITE INSTRUCTION — SLC500
The write message (M SG) command for a SLC500 is setup as follows:

3 MSG - N12:40 : {14 Elements) i [m] ]

Thiz Controller — Contral Bits
Commurication Command: [E00CPL wite | lgnore i timed out (T0): [0 ]

Data Table Address: @ To be retried [MR]: IE
Size in Elements: E Awaiting Execution [E4]: m
Channel:: EI Continuouz Run [COJ: m
} Emor [ER): @
- Target Device Message done [DN): [0]
Message Timeout : Message Transmitting (ST): [0 ]
[rata T able Address:

Message Enabled [EM]: m
Local Node Addr [dec]: [octall: ‘wiaiting for Queue Space : IE
Local 4/ Remote :

—Errar

Error Code[Hex): O

" Eror Dezcription

MNa ermors

Note: The Data Table Address can be any integer file address. The 10 elements written to the
M4500 PLC are defined in the last section — Read/Write Data Definitions.
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READ INSTRUCTION CONFIGURATION — CONTROLOGIX

The read message (M SG) configuration for a ControLogix PLC is setup as follows:

Message Configuration - msgReadl

Configuratior ! Eommunicatinnl Tag I

Message Type:

Source Element: IN?:U

Murnber OF Elements: {100

x|

Destination Element: IDF1_F|ead[EI] _'J Wew Tag... |
2 Enable ) Enable Waiting i) Start 2 Done Daone Length: 0
3 Enor Code: Extended Errar Code: [~ Timed Out &
Emar Path:
Erar Test:
Ok I Cancel | Aaply Help |
Message Configuration - msgRead2 ﬂ

Configuratior ! Eommunicatinnl Tag I

Message Type:

JN7100

Murnber OF Elements: IED 3:

Source Element:

Destination Element: IDF1_F|ead['IUD] _'J Wew Tag... |
2 Enable ) Enable Waiting i) Start 2 Done Daone Length: 0
3 Enor Code: Extended Errar Code: [~ Timed Out &
Emar Path:
Erar Test:
Ok I Cancel | Aaply | Help |

Note: The“Message Type’ isSLC Typed Read. The Destination Element can be any integer
array. The 150 elements (total) read from the M4500 PLC are defined in the last section —

Read/\Write Data Definitions.
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WRITE INSTRUCTION CONFIGURATION — CONTROLOGIX
The write message (M SG) configuration for a ControLogix PLC is setup as follows:

Message Configuration - msgWritel _)'_(!

Configuratior ! Eommunicatinnl Tag I

Message Type:

SLC Typed "Wiite
Saource Element: IDF1_W'rite[IJ] ﬂ Mew Tag... |
Mumber OF Elements: |1 0 3:

Deztination Element: IN?:1 50

2 Enable ) Enable Waiting i) Start 2 Done Daone Length: 0
3 Enor Code: Extended Errar Code: [~ Timed Out &
Emar Path:
Erar Test:

Ok I Cancel Aaply Help

Note: The“Message Type’ is SLC Typed Write. The Source Element can be any integer array.
The 10 € ements written to the M4500 PLC are defined in the last section — Read/Write Data
Definitions.
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COMMUNICATION TAB - CONTROLOGIX
The communication configuration for a ControLogix PLC is setup as follows:

Message Configuration - msgReadl . x|

Configuration”  Communication | Tag I

&+ Path: Iﬁ Browse... |

2.0
* Broadeast: I "i

Communication kethod

F P 0 DH+ Channel Il'i"" j' Destiriation Link: II:I 3_'
¢ CIF With Sauree ks ID 3: [estitiation Mode: |U 3: [Tetal]

Source (D
[T Gomnected [¥ Cache Connection: &
) Enable ) Enable Waiting (3 Start ) Done Dore Length: 0
3 Error Code: Extended Errar Code: [ Timed Qut &
Eror Path:
Errar Test:

ak. I Cancel | Apply | Help |

The “Path” describes the route the message takes to get to the destination. The format of the “ Path”
uses this format:
port, next_address

For serial DF1 communications, the port is“DF1 seria, channel 0" (Type = 2), next_addressisfor
the station address (0-254). Since there is only the direct link from channel 0 to the User Port on the
SA516-DF1 board, the next_addressis set for station 0.
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TAG TAB - CONTROLOGIX
The Tag configuration for a ControLogix PLC is setup as follows:

x
Eonfiguration*l Communication  Tad |
Mame:
Description: READ DATA 1 :I
[S4516-DF1]
Type: Base
Data Type:  MESSAGE
Scope: Eﬂ S4R16DF1_CLx
External Read Only
Access:
) Enable 3 Enable'#ating i} Start ) Done Done Length: 0
3 Eror Code Extended Ermror Code: [ Timed Out
Error Path:
Error Text:
(i} 4 I Caticel | Apply | Help |

Note: Thetag“DataType” must be MESSAGE and must be defined at the “Controller” scope
level.
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CHANNEL 0 SETUP

PLCS

The Channel 0 Seria Port should be setup as follows:

x
Channel 0 | Channel 14 | Channel 18 | Channel 24| Channel 28 |
Communication b ode i~ Remate Mode Change
& Spstemn [Point-T o-Point] Attentiar Ehar:l Wb
£ System (Slave " Enable System:IS
7 Systen (Master)
" User [ASCH) Llser:IU

Diaghostic FiIe:ID

Serial Port | Options l

Baud Rate: |SBDD 'l Parity: I Hone 'I
Bits Per Char: IS 'l Error Detect: | BCC hd
Stop Bits: |1 'l

(BT NG | F Ul D uples Modem

ak. I Cancel | Apply | Help

Note: The Communication Mode is setup for System (Point-to-Point).
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PLC5
The Channel 0 Options are setup as follows:

Edit Channel Properties =l

Channel 0 | Channel 14 | Channel 18 | Channel 24| Channel 28 |

Communication b ode - Remote Mode Change

& Spstemn [Point-T o-Point] Attentiar Char:l Wb
= Spstem [Slave) B

Enable Sugh _,;IS
7 Systen (Master) CeA]

' User [ASCI) USEfilL'
Diaghostic FiIe:ID

Serjal Port Options

Mak Receive: |3
CF1 ENGS:IB

ALK, Timeout [20ms]: ISD
[ Detect Duplicate Messages

Message Application Timeout: IBD zeconds b l

ak. I Cancel | Apply | Help |

Note: The"Detect Duplicate Messages’” should be unchecked.
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SLC500
The Channel 0 Seria Port should be setup as follows:

Channel Configuration x|

General I Chan. 1 - S_l,lsteml Chat. 0 - S_l,lsteml Chan. 0- Userl

Channel 1

Diriver: IE thermet

[~ white Protected

Pazzthru Link 1D [dec] |2

Edit Resource/Dwrer Timeout [#1 sec) |BU

Diagnostic File ID

— Channel 0

Spztem Driver:IDF‘I Full Cuplex User Diriver: IAS |
Mode: ISystem 'l [~ Mode Change Enabled

[ ‘write Protected Mode Attention Eharacterl\1 b
Pazsthru Link 1D [dec] I‘I System Mode CharacterlS
Edit Resource/Owner Timeout [+ 1sec) IBD User Mode Eha[acte[lu

Diagnostic File ID

aK I Cancel Apply Help
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SLC500
The Channel 0 Options are setup as follows:

Channel Configuration x|

Generall Chan. 1-System  Chan. 0 - Spstem | Chan. O- Userl

Diiver  |DFT Full Duplex Fji el
|9 [decimal]
Eaud | 9600 vl
Parity |NDNE vl
Stop Bits |1 vl

r— Protocaol Control

Contral Line INo Handzhaking j ACK Timeout (220 ms] IED_
Emor Detection I BCC j
Embedded Fesponses IEnabIed j

[ Duplicate Packet Detect MK Relies [?a_

EMNG Retries |3_

aK I Cancel | Apply | Help |

Note: The“Duplicate Packet Detect” should be unchecked.
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CONTROLOGIX
The Seria Port (Channel 0) should be setup asfollows:

ontroller Properties - S4516DF1_CLX ] 4]

Advanced | SFC Execution I File I Fiedundancy I Moreeolatile Memony I Memon
General Serial Part | Sypstem Protocol I User Pratacol I Major Faults I inor Faults I DratedTime

Shiow Dffline Yalues |

tode:

Baud R ate: 3600 -

Drata Bits: IE 'l
Parity: INone 'I
Stop Bits: |1 'l

Contral Line: W
™| Cantinuous Carier

RTS Serd Delay: [0 (s20ms)

RTS O Delagr |0 (<20 ms)

DCD Wait Delay: [0 il sec)

QK I Cancel I Aoply I Help

The “ System Protocol” should be setup as follows:

ontroller Properties - S4516DF1_CLX ] 4]

Advanced I SFC Execution | File I Fiedundancy I Moreeolatile Memony I Memon I
General I Serial Pot Swstem Protocsl | User Pratacol I Major Faults I inor Faults I DratedTime

Bt : ; = Error D etection

raotacol: IDF1 Pairt to Paint I ’7 = BCC " CRC
Station Address: ID

MAK. Receive Linit: |3

EMG Tratsmit Linnit: |3

ACK Timeout: |5E| [=20 mg]
Embedded Responses: IAutodeteCt 'I

™ Enable Duplicate Detection

QK I Cancel I Apply | Help |

Note: The*Enable Duplicate Detection” should be unchecked.
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READ/WRITE DATA DEFINITIONS

Data Read From The M4500 (150 Elements) Is Defined As Follows:

M4500 | Mapped | PLC
Description Add Add Add | Function
General:
M4500 Status Word 1 (to PLC) W4600 N7:0 R/O
Zero Speed (Bit 00)] F119 B4600.0 N7:0/0
Spare (Bit 01) B4600.1 N7:0/1
Spare (Bit 02) B4600.2 N7:0/2
thru thru thru
Spare (Bit 14) B4601.6 | N7:0/14
Spare (Bit 15) B4601.7 | N7:0/15
M4500 Status Word 2 (to PLC) W4602 N7:1 R/O
Zero Speed Output (Bit 00)] B121.4 | B4602.0 N7:1/0
Infeed Track Jam (Bit 01)] B121.5 | B4602.1 N7:1/1
No Can Transfer (Bit 02)] B121.6 | B4602.2 N7:1/2
Timing Signal Fail (Bit 03)] F124 B4602.3 N7:1/3
Spare (Bit 04) B4602.4 N7:1/4
Spare (Bit 05) B4602.5 N7:1/5
thru thru thru
Spare (Bit 14) B4603.6 | N7:1/14
Spare (Bit 15) B4603.7 | N7:1/15
Resolver Pos. W180 W4604 N7:2 R/O
Resolver RPM w182 W4606 N7:3 R/O
Resolver Period w184 W4608 N7:4 R/O
Resolver Scale Factor W186 W4610 N7:5 R/O
Resolver Offset W188 W4612 N7:6 R/O
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M4500 | Mapped | PLC
Description Add Add Add | Function
Shift Data (Trips Per Spindle):
Last Spindle Tripped B598 W4614 N7:7 R/O
Trips Per Spindle #1 W1020 | W4616 N7:8 R/O
thru thru thru thru R/O
Trips Per Spindle #24 W1066 | W4662 N7:31 R/O
Shift Data (Current Shift):
Good Cans (Lo) W1100 | W4664 N7:32 R/O
Good Cans (Hi) W1102 | WA4666 N7:33 R/O
Total Blowoffs (Lo) W1104 | W4668 N7:34 R/O
Total Blowoffs (Hi) W1106 | WA4670 N7:35 R/O
Misload Count (Lo) W1108 | W4672 N7:36 R/O
Misload Count (Hi) W1110 | WA4674 N7:37 R/O
Restart Blowoffs (Lo) W1112 | W4676 N7:38 R/O
Restart Blowoffs (Hi) W1114 | W4678 N7:39 R/O
Manual Blowoffs (Lo) W1116 | W4680 N7:40 R/O
Manual Blowoffs (Hi) W1118 | W4682 N7:41 R/O
QC Blowoffs (Lo) W1120 | W4684 N7:42 R/O
QC Blowoffs (Hi) W1122 | W4686 N7:43 R/O
Trips Per Spindle #1 W1124 | W4688 N7:44 R/O
thru thru thru thru R/O
Trips Per Spindle #24 W1170 | W4734 N7:67 R/O
Shift Data (Last Shift):
Good Cans (Lo) W1200 | WA4736 N7:68 R/O
Good Cans (Hi) W1202 | WA4738 N7:69 R/O
Total Blowoffs (Lo) W1204 | W4740 N7:70 R/O
Total Blowoffs (Hi) W1206 | WA4742 N7:71 R/O
Misload Count (Lo) W1208 | W4744 N7:72 R/O
Misload Count (Hi) W1210 | WA4746 N7:73 R/O
Restart Blowoffs (Lo) W1212 | W4748 N7:74 R/O
Restart Blowoffs (Hi) W1214 | W4750 N7:75 R/O
Manual Blowoffs (Lo) W1216 | W4752 N7:76 R/O
Manual Blowoffs (Hi) W1218 | W4754 N7:77 R/O
QC Blowoffs (Lo) W1220 | WA4756 N7:78 R/O
QC Blowoffs (Hi) W1222 | WA4758 N7:79 R/O
Trips Per Spindle #1 W1224 | W4760 N7:80 R/O
thru thru thru thru R/O
Trips Per Spindle #24 W1270 | W4806 N7:103 R/O
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M4500 | Mapped | PLC

Description Add Add Add | Function
Setup (Print Carriage/Varnish Unit):

Print Carriage Retract (out) Response Time B1012 | w4808 N7:104 R/O
Print Carriage Extend (in) Response Time B1013 | w4810 N7:105 R/O
Varnish Unit Retract (out) Response Time B1014 | w4812 N7:106 R/O
Varnish Unit Extend (in) Response Time B1015 | w4814 N7:107 R/O

Setup (Bad Can Pin Chain Blowoff):

# to Blowoff from Infeed Open B1000 | w4816 N7:108 R/O
# to Blowoff from Print at Restart B1001 W4818 N7:109 R/O
# to Blowoff from Varnish at Restart B1002 W4820 N7:110 R/O
# to Blowoff for each Misload B1003 W4822 N7:111 R/O
Pins to Pinchain Blowoff Port W1004 | w4824 N7:112 R/O
Blowoff Solenoid ON Response Time B1006 | W4826 N7:113 R/O
Blowoff Solenoid off Response Time B1007 | w4828 N7:114 R/O

Setup (QC Pin Chain Blowoff):

Blowoff Solenoid ON Response Time B1008 | w4830 N7:115 R/O
Blowoff Solenoid off Response Time B1009 | w4832 N7:116 R/O
QC Can Blowoff Port Shift Offset B1010 W4834 N7:117 R/O
Spindle Trip Shift Offset B1011 | W4836 N7:118 R/O
Setup Passcode W1070 | W4838 N7:119 R/O

Timing Channel Setpoints:

CHOO - Carriage Trip Timing (on) w4840 N7:120 R/O
CHOO - Carriage Trip Timing (off) w4842 N7:121 R/O
CHO01 - Varnish Trip Timing (on) w4844 N7:122 R/O
CHO1 - Varnish Trip Timing (off) w4846 N7:123 R/O
CHO02 - Can/No Can Clock (on) w4848 N7:124 R/O
CHO02 - Can/No Can Clock (off) w4850 N7:125 R/O
CHO03 - Damaged Can Blowoff Low Speed (on) w4852 N7:126 R/O
CHO03 - Damaged Can Blowoff Low Speed (off) w4854 N7:127 R/O
CHO04 - Damaged Can Blowoff High Speed (on) w4856 N7:128 R/O
CHO4 - Damaged Can Blowoff High Speed (off) w4858 N7:129 R/O
CHOS5 - Pin Chain Blowoff Timing (on) w4860 N7:130 R/O
CHOS5 - Pin Chain Blowoff Timing (off) W4862 N7:131 R/O
CHO06 - QC Blowoff Timing (on) w4864 N7:132 R/O
CHO06 - QC Blowoff Timing (off) W4866 N7:133 R/O
CHO7 - Can Gate Timing (on) w4868 N7:134 R/O
CHO7 - Can Gate Timing (off) w4870 N7:135 R/O
CH10 - PLC Clock Timing (on) W4872 N7:136 R/O
CH10 - PLC Clock Timing (off) W4874 N7:137 R/O
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M4500 | Mapped | PLC
Description Add Add Add |Function
Setup:
Infeed Open Number of Shifts B1019 | w4876 N7:138 R/O
Number of Segments on Blanket wheel B1018 | w4878 N7:139 R/O
Spare Registers:
Spare W4880 N7:140 R/O
Spare W4882 N7:141 R/O
thru thru thru thru
Spare W4896 N7:148 R/O
Spare W4898 N7:149 R/O
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Data Written To The M4500 (10 Elements) Is Defined As Follows:

M4500 | Mapped | PLC
Description Add Add Add |Function
General:
PLC Status Word 1 (from PLC) W4900 N7:150 W/O
Reset Spindle Trips (Bit 00) B4900.0 | N7:150/0
End of Shift (Bit 01) B4900.1 | N7:150/1
QC Initiate (Bit 02) B4900.2 | N7:150/2
Trip Test (Bit 03) B4900.3 | N7:150/3
Spare (Bit 04) B4900.4 | N7:150/4
Spare (Bit 05) B4900.5 | N7:150/5
thru thru thru
Spare (Bit 14) B4901.6 |N7:150/14
Spare (Bit 15) B4901.7 |N7:150/15
PLC Status Word 2 (from PLC) N7:151 W/O
Spare (Bit 00) B4902.0 | N7:151/0
Spare (Bit 01) B4902.1 | N7:151/1
thru thru thru
Spare (Bit 14) B4903.6 |N7:151/14
Spare (Bit 15) B4903.7 |N7:151/15
QC Spindle Number (1-24, 25,26) W4904 N7:152 wW/O
Spare W4906 N7:153 wW/O
Spare W4908 N7:154 wW/O
thru thru thru thru
Spare W4916 N7:158 wW/O
Spare W4918 N7:159 w/O
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